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Legal information
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Preface

This documentation contains all the information you need to get started with Industrial Edge (IE) 
and is intended for operators who commission the Industrial Edge Management (IEM). 
The complete operating manual for operators who, for example, commission and operate 
Edge Devices, as well as service and maintenance technicians who perform error analysis, is 
included in the "Industrial Edge Management ‑ Operation (https://
support.industry.siemens.com/cs/us/en/view/109780393)" manual.
The documentation for programmers who develop respectively package their own Edge Apps 
and load these Edge Apps to the IEM through the Industrial Edge App Publisher is included in the 
"Industrial Edge App Publisher ‑ Operation (https://support.industry.siemens.com/cs/us/en/
view/109780392)" manual.
New features, known issues and notes on use regarding new published versions of the Industrial 
Edge Management are included in the "Industrial Edge ‑ Release Notes (https://
support.industry.siemens.com/cs/us/en/view/109780394)" manual.
An overview with regard to security for Industrial Edge and its components are included in the 
"Industrial Edge ‑ Security overview (https://support.industry.siemens.com/cs/us/en/view/
109781002)" manual.
Information regarding Edge Devices and their operations are included in the "Industrial Edge 
Device - Operation (https://support.industry.siemens.com/cs/us/en/view/109783785)" manual.
Instructions and sequences to update Industrial Edge and its components are included in the 
"Industrial Edge - Update Procedures (https://support.industry.siemens.com/cs/us/en/view/
109795343)" manual.
Requirements and procedures on publishing apps to the IE Hub are included in the 
"Industrial Edge - Publishing Apps to the IE Hub (https://support.industry.siemens.com/cs/us/en/
view/109803581)" manual. 

Purpose of this document
The objectives of this documentation include the following:
• You are provided with a functional overview of Industrial Edge.
• You find all the information on how to set up the Industrial Edge Management (IEM) On-

Premises.
• You learn how to connect an Edge Device to your IEM and install Edge Apps onto 

Edge Devices. 

Basic knowledge required
• Solid knowledge of personal computers is required.
• Solid knowledge of Linux-based operating systems is required.
• Solid knowledge of Linux-based command lines is required.
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• Solid knowledge of IP-based networks is required.
• Solid knowledge of Docker is required.
• General knowledge in the field of IT is required.
• General knowledge in the field of automation technology is recommended.

Scope of this document
This Getting Started is valid for Industrial Edge.

Convention
The term "Edge Device" is used in this documentation to designate hardware with a configured 
Industrial Edge Device OS. 
Instead of the product designation "Industrial Edge Apps", the short forms "Edge Apps" and 
"Apps" are also used.  
Instead of the product designation "Industrial Edge System Apps", the short form "System Apps" 
is also used.
Instead of the product designation "Industrial Edge Device", the short form "Edge Device" is also 
used.
Instead of the product designations "Industrial Edge Databus" and "Industrial Edge 
Databus Configurator", the short forms "Databus" and "Databus Configurator" are also used 
respectively.
Instead of the product designations "Industrial Edge Cloud Connector" and "Industrial Edge 
Cloud Connector Configurator", the short forms "Cloud Connector" and "Cloud Connector 
Configurator" are also used respectively.

Figures
Picture components are marked with black position numbers on a white background: ①, ②, ③, 
etc. 
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Industrial security 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit (http://www.siemens.com/industrialsecurity).
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at (https://support.industry.siemens.com/cs/start?).
Follow the recommendations stated in this document. In addition, observe and follow the 
security statements, which are valid for this documentation, from the 
"Industrial Edge ‑ Security Overview (https://support.industry.siemens.com/cs/us/en/view/
109781002)" manual. Following these recommendations and security statements ensures that 
Siemens will provide correct response in case some vulnerabilities are found in the system. 
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Overview of Industrial Edge 2
Industrial Edge combines local engineering with Cloud engineering.
Industrial Edge provides you with the following options:
• Install and use apps as required
• Distribution of apps to individual or grouped Edge Devices
• Availability of local data and, if desired, global data
• Regular software update cycles for Edge Devices and Edge Apps
• Pre-processing of data with low latency times 
• Regular maintenance and updates of your system
• Management of associated Edge Devices and Edge Apps
• Development of custom Edge Apps
• Connectivity to your IT system and to automation
• Transfer of data with IT and cloud systems

Industrial Edge Management - Getting Started 08/22
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Industrial Edge consists of the following main components:
• Industrial Edge Hub (IEH): 

The Industrial Edge Hub (IEH) is placed in the cloud level and is the central starting point of 
Industrial Edge. From the IEH, you download the Industrial Edge Management OS to enable 
the IEM on‑premises and all necessary software for running the IEM. Furthermore, the IEH 
provides an app catalog where you purchase available Edge Apps. All necessary 
documentation and information about Industrial Edge is also available in the IEH.

• Industrial Edge Management (IEM):
The Industrial Edge Management is placed in the factory level and is the central 
infrastructure of Industrial Edge. The Industrial Edge Management is available as local IEM 
On-Premises. The Industrial Edge Management allows you to manage both connected 
Edge Devices and Edge Apps that you install individually on each Edge Device. The Industrial 
Edge Management also provide tools for managing Edge Devices and tracking analytics. 
Developers also have the possibility to create new projects using collaboration features and 
role-based access for co-developers.

Overview of Industrial Edge
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• Industrial Edge Devices:
Industrial Edge Devices (IEDs) are placed in the field level where the data generation and 
acquisition from automation systems take place. Edge Devices can store automation data 
locally and retrieve it as needed. In addition, Edge Devices can load this data to the cloud 
infrastructure (e.g. MindSphere) and retrieve it at any time. Once provisioned and 
connected, the IEM activates the Edge Device through an Edge Device configuration file.

• Industrial Edge Apps:
Industrial Edge Apps are used for intelligent processing of automation data. Edge Apps are 
available from Siemens, business partners (App Partners), third-party vendors or from your 
own development. You use the IEM to configure, install and maintain these Docker 
containerized Edge Apps to targeted Edge Devices.

• Industrial Edge App Publisher (IEAP):
The Industrial Edge App Publisher is a software application to package Docker images to 
Industrial Edge Apps and to publish these Industrial Edge Apps to your IEM. The 
Industrial Edge Apps can then be installed on Industrial Edge Devices. The IEAP is available for 
Windows and Linux operating systems.

Overview of Industrial Edge
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Industrial Edge Hub 3
3.1 Sign up

Requirement
• You have purchased access to the Industrial Edge Hub.

Note
Purchasing access to the Industrial Edge Hub
You purchase access to the Industrial Edge Hub in the Siemens Industry Mall or in the IE 
Marketplace. The purchasing process requires an email address and the allocated location. 

• You have received a welcome email containing the URL of the Industrial Edge Hub.
Note
Receiving the welcome email
You receive the welcome email after you have purchased access to the Industrial Edge Hub. 
It takes some time between the purchase process and the receipt of the welcome email.
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Procedure
1. After you have received the welcome email containing the URL of the Industrial Edge Hub, 

open the Industrial Edge Hub by clicking the link in the welcome email. 
The login screen for Industrial Edge Hub is displayed.

2. Click the "Sign up" tab.
3. Enter the following parameters in the according input fields:

– Email address: Email address that has been specified for the Industrial Edge Hub access
– Password: Password to log in to the Industrial Edge Hub

Note
Password requirements
The password must meet at least 8 characters, 1 upper-case letter, 1 special character and 
1 number.

– First name: First name of the email user 
– Last name: Last name of the email user
All input fields are mandatory.

4. Read and accept the terms of use.

Industrial Edge Hub
3.1 Sign up
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5. Click "Sign Up".
The "Welcome" screen is displayed.

6. Check your data.
7. If everything is correct, click "Continue". 

Note
Incorrect data
If the data is incorrect, click the link to contact the Siemens support.
The "Confirmation of delivery address and Export Control Clause" screen is displayed.

The displayed export regulations in the screen depend on your location, here for example 
Germany.

Industrial Edge Hub
3.1 Sign up
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8. Before entering the Industrial Edge Hub, read the export regulations. 
9. Accept the export regulations by selecting the 2 check boxes.

The acceptance will be logged in the Industrial Edge Hub database along with the date of 
acceptance.

10.When both check boxes are selected, click "Continue".
The home page of the Industrial Edge Hub is displayed.

3.2 Log in and sign out

Requirement
• You have purchased the Industrial Edge Hub access.
• You have successfully signed up to the Industrial Edge Hub.

Log in
1. Open the IE Hub by entering the URL into an Internet browser.

The login screen is displayed.

2. In the "Login" screen, enter your email address and your password in the according input 
fields.

Industrial Edge Hub
3.2 Log in and sign out
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3. Click "Log in".
The "Organization Selection" screen is displayed.

You have the possibility, to be registered in several IE Hub organizations. If you are registered 
in several IE Hub organizations, these IE Hub organizations are displayed in this screen. All 
resources, registered users, available licenses and assigned apps are only valid in the specific 
IE Hub organization you log into. The IE Hub organization name is generated automatically 
by the system without any meaning or semantics and cannot be changed. The display name 
can be renamed under "Organization Settings" once you are logged into the IE Hub.
If you are registered in just 1 IE Hub organization, the IE Hub organization will open directly 
without the selection of an IE Hub organization.

4. Select the check box of the IE Hub organization you want to log into.

Industrial Edge Hub
3.2 Log in and sign out
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5. Click "Continue".
The "Confirmation of delivery address and Export Control Clause" screen is displayed.

The available export regulations in the screen depend on your location, here for example 
Germany.  

6. Before entering the IE Hub, you must read the export regulations. 
7. Accept the export regulations by selecting the 2 check boxes.

The acceptance will be logged in the IE Hub database along with the date of acceptance.
8. When both check boxes are selected, click "Continue".

The home page of the IE Hub is displayed.
Note
IE Hub URL
The IE Hub URL adapts to the generated IE Hub organization name. For example, when the 
organization name is "core", the URL will be "https://core.iehub.eu1.edge.siemens.cloud". 
You can directly log into specific IE Hub organizations by using the respective URL.

No access to the Industrial Edge Hub
If you try to sign into the Industrial Edge Hub without having purchased access to the Industrial 
Edge Hub, the following screen is displayed:

Industrial Edge Hub
3.2 Log in and sign out
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Purchase access to the Industrial Edge Hub in the Siemens Industry Mall by clicking the link.

Sign out
1. Click the user icon in the top right corner.
2. Click "Logout".

You are signed out from the IE Hub.

3.3 Home
After you log into the IE Hub, the "Home" screen of the IE Hub is displayed.
The following figure shows the IE Hub home page: 

Industrial Edge Hub
3.3 Home
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By clicking the button within the tiles, you navigate to the according menu item. By clicking 
"Access MindSphere", you will be redirected to MindSphere.
The IE Hub provides the following navigation menu:
• Home
• Application Management
• Library
• Licenses
• IEM Instances 
• Download Software
• Documents
• User Management
• Organization Settings

Notifications
By clicking the  icon, the "Notifications" screen with all notifications referring to the IE Hub is 
displayed. For example, whenever 1 of the following events occur, the according notification is 
displayed in the "Notifications" screen:
• Purchased Edge Device licenses
• Purchased Edge App licenses
• Releases of new Industrial Edge Management OS
• Releases of new Industrial Edge Device OS

Industrial Edge Hub
3.3 Home
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• Releases of new Edge App versions
• Updates of Edge Apps

IE Hub under maintenance
When the IE Hub is under maintenance or when new features and components are getting 
deployed, the following message will be displayed in the IE Hub.

In this maintenance interval, you cannot use the IE Hub. After the required work is done, the 
message is removed from the IE Hub and you can use again the IE Hub.

Industrial Edge Hub
3.3 Home
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3.4 Application Management

3.4.1 Overview

Publishing Apps to the IE Hub
In the "Application Management" screen, you have the possibility to publish apps to the IE Hub. 
To do so,  you must accept the Ecosystem Agreement. 

You find more information on the Ecosystem Agreement and information on how to publish 
apps to the IE Hub in the "Industrial Edge - Publishing Apps to the IE Hub (https://
support.industry.siemens.com/cs/us/en/view/109803581)" manual. 

Granting access to Application Management APIs
After you have accepted the Ecosystem Agreement, the  icon is enabled in the top right 
corner in the header of the IE Hub. Through this icon, you can create maximum 3 accounts 
whom you can grant access to the Application Management APIs. 

Industrial Edge Hub
3.4 Application Management

Industrial Edge Management - Getting Started 08/22
24 Getting Started, 08/2022, A5E50177870-AK

https://support.industry.siemens.com/cs/us/en/view/109803581
https://support.industry.siemens.com/cs/us/en/view/109803581


You find more information on how to grant access to Application Management APIs in the 
"Industrial Edge - Publishing Apps to the IE Hub (https://support.industry.siemens.com/cs/us/en/
view/109803581)" manual. 

3.5 Library
The "Library" screen lists all apps for which you purchased a license and which you can transfer 
to your IEM instances. 
System Apps are included in the purchase of the Industrial Edge Management, so you do not 
have to purchase a license for System Apps. You can directly copy the System Apps to the catalog 
of an IEM instance.  
The following figure shows an example of the "Library" screen:

① Licensed app 
② Search for an app 
③ App version
④ Copy app to IEM instances
⑤ Filter apps
⑥ Open app documentation
⑦ Open Industrial Edge Marketplace

To purchase apps and app licenses, visit the Industrial Edge Marketplace.
By clicking an app tile, you can check the license details of the respective app, for example: 

Industrial Edge Hub
3.5 Library
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If a license report was sent from the IEM to the IE Hub, the report is displayed in this screen.

① IEM instance
② Number of used licenses on the corresponding IEM instance
③ Creation date of the report

You find more information on creating and sending a license report from the IEM to the IE Hub 
in the "Admin UI > Licenses" subsection in the "Industrial Edge Management - Operation" 
manual.

Note
If an IEM instance is deleted from the IE Hub, reports that belong to the deleted IEM instance will 
be deleted too.

Industrial Edge Hub
3.5 Library
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3.5.1 Copying an app to IEM instances

Procedure
Copying an app to IEM instances requires a created IEM instance and an Internet connection. 
With this functionality, you send the app directly to the catalog of the Management UI of the IEM 
instances. 
To copy an app to IEM instances, proceed as follows:
1. Click the  icon of the app you want to copy to IEM instances. 

The "Copy Application to IEM Catalog" screen is displayed. 
2. Select all the IEM instances you want to send the app to.  

Note
You can also search for the name of an IEM instance.

3. Click "Copy". 
An according job is created. You can check the job status in the job status screen in the 
Managemet UI of the respective IEM instances.  

3.5.2 Opening app documentation
If the app provides a documentation, the app tile contains the documentation icon. 

By clicking the icon, you will be redirected to the documentation page.

3.5.3 Purchasing an app
You purchase apps respectively app licenses in the IE Marketplace. To be able to purchase apps, 
you need an access code. To get this access code, contact the regional Siemens contact person.

Requirement
You have received the access code from the regional Siemens contact person.

Industrial Edge Hub
3.5 Library
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Procedure
1. In the "Library" screen of the IE Hub, click "Industrial Edge Marketplace".

2. Click "Manufacturing & Process Industries".
The Industrial Edge Marketplace is opened. 

Industrial Edge Hub
3.5 Library
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3. Click the tile of the app you want to purchase, in this example the "Energy Manager" app.
The app description and app details are displayed. 

On the left, you find all prerequisites and requirements needed to run this app in the IEM.

You can purchase all these required products in 1 transaction. 
4. Enter the amount of required licenses in the "Quantity" input field.
5. In the "Access Code" input field, enter the received access code.

Industrial Edge Hub
3.5 Library

Industrial Edge Management - Getting Started 08/22
Getting Started, 08/2022, A5E50177870-AK 29



6. Click "Add to Cart".
The cart is displayed.

7. If not yet purchased, add all required products to the cart. 
For that, you can click the respective links under "Prerequisites" and add all needed products 
to the cart in the same manner.
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8. From the "Payment Type" drop-down list, select your favored payment type.
For 3rd party apps, only the "Credit Card" payment type is available.

9. Check again your provided information.
Note
You can edit again the amount of licenses and apply the changes by clicking "Apply Quantity 
Changes".

10.Click "Checkout" and follow the instructions on the screen.

After you have purchased the app, the app is displayed in the IE Hub under "Library". From 
there, you can copy the app to your IEM instances. The amount of licenses, the license itself 
and further information are displayed under "Licenses". If needed, you can purchase more 
licenses of the respective app from there.

3.6 Licenses
The "Licenses" menu item lists all licenses and subscriptions that you ordered. 
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3.6.1 Purchased app licenses
The "Applications" tab lists all app licenses that you have purchased. The following figure shows 
the "Applications" tab as an example:

① Purchased apps
② • Number of valid licenses in total of the selected app

• Free licenses that can be used
• Number of used licenses

③ App name
④ License report table including:

• IEM instance
• Number of used licenses on the corresponding IEM instance
• Creation date of the report

⑤ Link to the respective app in the IE Marketplace to purchase more licenses

System Apps and your own apps are not listed in this screen. 
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3.6.2 Purchased Edge Device licenses
The "Devices" tab displays the amount of Industrial Edge Device licenses that you have 
purchased from the IE Marketplace. The following figure shows the "Devices" tab as an example:

1 license enables the connection and management of 1 Industrial Edge Device. By default, 1 
license is included at no charge with each Industrial Edge Management system. To purchase 
more Edge Device licenses, click "Purchase more licenses on Marketplace". In the IE Marketplace, 
purchase the amount of licenses you require to permanently onboard and manage your 
Industrial Edge Devices within your Industrial Edge Management system.
If a license report was sent from the IEM to the IE Hub, the report is displayed in this screen. 
Similar to purchased app licenses, the table shows:
• IEM instance
• Number of used licenses on the corresponding IEM instance
• Creation date of the report
You find more information on creating and sending a license report from the IEM to the IE Hub 
in the "Admin UI > Licenses" subsection in the "Industrial Edge Management - Operation" 
manual.

3.6.3 Purchased licenses
The "Purchases" tab lists all licenses and subscriptions of your purchased products. The tab is 
divided into the "Industry Mall" and the "Industrial Edge Marketplace" section.
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The "Industry Mall" section lists all purchased licenses. The following figure shows the "Industry 
Mall" section as an example:

① Product name and order number (MLFB)
② Purchaser email address
③ Customer email address
④ Date of order
⑤ Download license file

The "Industrial Edge Marketplace" section lists all subscriptions that you ordered from the IE 
Marketplace. The following figure shows the "Industrial Edge Marketplace" section as an 
example:
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① Subscription ID
② Product name
③ Email address of the purchaser
④ Subscription start
⑤ Subscription end
⑥ Auto-renewal status
⑦ Number of subscriptions

The auto-renewal status indicates whether the product license that is about to expire will be 
automatically renewed or not when the subscription end is reached.
Product licenses that are marked with the  icon will not be automatically renewed when the 
subscription end is reached and will not be available anymore after subscription end. Product 
licenses that are marked with the  icon will be automatically renewed when the subscription 
end is reached. In both cases, if you want to change the auto-renewal status, contact the product 
purchaser.

3.7 IEM Instances
The "IEM Instances" screen lists all existing IEM instances and provides the following functions:
• Creation of new IEM instances
• Management of IEM instances
When you create a new IEM instance, the IEM instance is added to the table and a configuration 
file is created. This configuration file contains the configuration for the IEM that you need to set 
up the IEM instance.
The following figure shows the "IEM Instances" screen as an example:
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① Create New IEM Instance
② IEM instances table

Listed IEM instances inclusive following information:
• Name: Name of the instance
• Description: Description of the respective instance
• Creator: E-mail address of the instance's creator
• Configuration Date: Creation date of the instance
• Status: Status of the instance

– Online: IEM instance is running 
– Offline: IEM instance is offline since minimum 15 minutes 

• Actions: Manage instance
– Edit instance description
– Download configuration file
– Delete instance

Note
Description and creator of IEM instances
With IE release 06/22, the description and the creator of an IEM instance is also displayed in the 
table. For IEM instances, that have been created with earlier IE versions, the respective columns 
are empty. For these IEM instances, you can add a description afterwards.
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3.7.1 Managing IEM instances

Creating an IEM instance
When you click "Create New IEM Instance", you create an IEM instance and the according 
configuration file which you need for setting up your IEM instance. You find the detailed 
procedure to create an IEM instance in the "Creating IEM instance and downloading the 
configuration file (Page 55)" subsection.

Editing IEM instance description
To edit (or to add) an IEM instance description, click the  icon of the respective instance. Enter 
the description and save the changes by clicking "Save".

Downloading an IEM configuration file
To download an IEM configuration file, click the  icon of the respective instance. The 
configuration file is downloaded to the standard download folder of your Internet browser. 

Deleting an IEM instance
1. Click the  icon of the respective instance. 

A warning is displayed.

If you delete the IEM instance, all data corresponding to this IEM instance will be deleted 
irrecoverable.

2. To confirm the deletion, click "Yes".
The IEM configuration is deleted from the IEH.

3.8 Download Software
In the "Download Software" screen you download all necessary software for running the IEM.
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In the "Initial Setup Tools" tab, you download the Industrial Edge Management OS which runs on 
a VM. From the "Update Packages" tab, you download the software update package to update 
the Industrial Edge Management. From the "Developer Tools" tab, you download the Windows 
respectively Linux version of either the UI based software or the CLI (command line interface) of 
the Industrial Edge App Publisher. In addition, you can download the Industrial Edge Control (IE 
CTL), the Command Line Interface to interact with Industrial Edge and its components. 
By clicking the "Download" button of the corresponding software, the software is downloaded 
to the standard download folder of your Internet browser.
The respective software also includes links for its open source software (OSS) sources and for the 
OSS readme. By clicking 1 of the links, the respective file is being downloaded.

3.9 Documents
In the "Documents" screen, you get the necessary documentation and additional information 
regarding Industrial Edge. 
You can open all documents either as PDF or HTML file.

3.10 User Management

3.10.1 Overview
It is possible to be registered in several IE Hub organizations. In the "User Management" section, 
you get an overview of all registered users in the logged IE Hub organization and also a list of 
invited users who have not yet accepted the invitation to access this IE Hub organization. You can 
invite new users to this IE Hub organization, delete users from the organization and manage 
roles assigned to the users.
The "User Management" screen is displayed as follows for example:
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① Invite new users to your IE Hub organization
② Registered users
③ Filter respective column
④ Manage user roles
⑤ Delete user 
⑥ Pending users

Note
Filtering can also be combined with several columns.

Inviting new users, deleting users and managing user roles is only available for users with the 
"ORGANIZATION_ADMIN" role.
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3.10.2 Inviting a new user

Requirement
The "ORGANIZATION_ADMIN" role is assigned to you. 

Procedure
1. Click "Invite User".

The "Invite User" screen is displayed.

2. In the "Email" input field, enter the email address of the user you want to invite to the IE Hub 
organization.

3. In the "Location" drop-down list, select the location of the respective user.
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4. Select the roles you want to assign to the user. 

Note
By clicking the  icon next to a role, all permissions assigned to the role are displayed.  
The "USER" role is assigned by default to the invited user. The "ORGANIZATION_ADMIN" role 
will be automatically assigned to the first registered user of the IE Hub organization. In 
addition to these roles, some other roles with specific features and content, for example the 
"DEVICE_BUILDER" or "APP_SELLER" role, do also exist. To enable these roles in your IE Hub 
Organization, contact the IE Ecosystem.  
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5. Add the selected roles to the user by clicking the  icon.

6. Click "Save".
A warning is displayed related to access of resources.

7. Click again "Save".
The invitee will be added to the "Pending Invitations" list and an email will be sent to the 
invitee. The invitee then must activate his account by signing up to the IE Hub (Page 15). After 
the invitee has activated his account, the invitee will move to the "Active Users" list and is able 
to access the IE Hub with the roles that are assigned to the user. 

3.10.3 Managing user roles

Requirement
The "ORGANIZATION_ADMIN" role is assigned to you. 

Procedure
1. Click the  icon of the user whose roles you want to manage.

The "Edit Roles" screen is displayed.
2. Add new roles to the user by selecting the respective roles from the "Available Roles" list and 

by clicking the  icon.
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3. Remove assigned roles from the user by selecting the respective roles from the "Current 
Roles" list and by clicking the  icon. 

4. To save your changes, click "Save". 

3.10.4 User roles
The following user roles are available.

User
Basic role for using the IE Hub. Includes read-only access to IE Hub resources.

Device Builder
Role for Device Builders which enables access to specific content on the IE Hub for Device 
Builders.

Organization Admin
Administrative role of the IE Hub organization. This role enables creation, modification and 
deletion of users, IEM instances and organizational resources.

App Seller
Role for app sellers. This role enables publishing apps to the IE Marketplace and deleting apps 
from there.

IEM Manager
Required role to manage IEM instances on the IE Hub and to download the IEM configuration file.

Unsubscribed User
Role for users who belong to a canceled IE Hub subscription. The role has limited scope to access 
certain IE Hub resources.
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Permissions
User role Permissions
User • Read firmware release resources

• Read firmware artifact resources
• Read firmware resources
• View licenses
• View notifications
• View subscriptions
• View IEHub artifacts
• Accept ECC document
• View IEM instance configuration
• View IEM instances
• View users
• View user roles
• View apps
• Transfer apps to IEM instances
• View app versions 
• Create and manage app versions
• Delete app versions
• View access rights for an app
• Accept or reject access rights for an app
• View Device Types
• View application agreement
• Manage app
• Delete app
• View marketplaces for an app
• View system settings
• View API user

Device Builder • Download Device Builder specific artifacts
• Create IEM instances with Device Builder features

Organization 
Admin

• Accept application agreement
• Create API user
• Delete API user
• Create and manage IEM instances
• Invite users
• Manage users
• Manage IE organization
• Configure user roles

App Seller • Release approval of an app
• Manage marketplace for an app 
• Delete app from marketplace 
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User role Permissions
IEM Manager • Create IEM instances

• Edit IEM instances
• Download IEM configuration file
• Delete IEM instances

Unsubscribed 
User

• View licenses
• View subscriptions
• View application agreement
• View access rights for an app
• View marketplaces for an app
• View apps
• View IEM instances
• Accept ECC document
• View users
• Invite users
• Manage users
• View app versions
• View system settings

3.11 Organization Settings

3.11.1 Overview
In the "Organization Settings" screen, you can check the IE Hub organization name and creation 
date, as well as renaming the IE Hub organization display name.
The following figure shows an example of the "Organization Settings" screen:
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① IE Hub organization display name
② IE Hub organization name
③ Creation date

Organization name and display name are also displayed when you click the user icon:
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3.11.2 Renaming IE Hub organization display name
The IE Hub organization name is generated automatically by the system without any meaning 
or semantics and cannot be changed. However, to clearly correlate IE Hub organizations and to 
distinguish between several IE Hub organizations, you can rename the IE Hub organization 
display name. Via this display name, you can recognize IE Hub organizations.

Note
IE Hub URL
The IE Hub URL adapts to the generated IE Hub organization name. For example, when the 
organization name is "core", the URL will be "https://core.iehub.eu1.edge.siemens.cloud". You 
can directly log into specific IE Hub organizations by using the respective URL.

Procedure
1. In the "Display Name" input field, enter the IE Hub organization display name.

The name must not contain a blank and must contain just alphanumeric characters. 
2. Click "Save".

The IE Hub organization display name is renamed.

3.12 Notification Settings
In the "Notification Settings", you can enable or disable e-mail notifications and IE Hub 
notifications displayed via the "Notifications" screen in the IE Hub. To open the "Notification 
Settings", click the user icon in the top-right corner and then "Profile".

The "Notification Settings" screen is displayed as follows for example.
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① Information type
② Enable or disable e-mail notifications
③ Enable or disable IE Hub notifications via the "Notifications" screen

E-mail notification and IE Hub notification settings in the first table are system wide settings and 
are valid for all IE Hub organizations in which you are registered. Changing settings in this table 
will be also changed accordingly and automatically in all other IE Hub organizations in which you 
are registered. E-mail notification and IE Hub notification settings in the second table are just 
valid for the current IE Hub organization. Changing settings in this table will be applied only for 
this IE Hub organization.
If you disable e-mail or IE Hub notifications of a specific information type, you will no longer 
receive any e-mails or IE Hub notifications respectively from this information type. Also if you 
disable IE Hub notifications of a specific information type, all notifications of this information 
type will be hidden in the "Notifications" screen in the IE Hub. If you enable an information type, 
you will again receive any e-mails or IE Hub notifications respectively from this information type. 
Also if you enable an information type, all notifications of that respective information type will 
be displayed again.
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3.13 Switching IE Hub organization
If you are registered in several IE Hub organizations, you can switch from 1 IE Hub organization 
to another one. 

Procedure
1. Click the user icon in the top right corner.
2. Click "Switch Organization".

The "Organization Selection" screen is displayed.

3. Select the check box of the IE Hub organization you want to switch to.
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4. Click "Continue".
The "Confirmation of delivery address and Export Control Clause" screen is displayed.

The available export regulations in the screen depend on your location, here for example 
Germany.  

5. If not done yet, read the export regulations. 
6. Accept the export regulations by selecting the 2 check boxes.
7. Click "Continue".

3.14 Cancelling an IE Hub subscription
If you do not want to extend your IE Hub subscription, you can cancel the subscription. To cancel 
your IE Hub subscription, contact the Industrial Edge Support. Only the IE Support can cancel 
your IE Hub subscription. After your cancellation has been approved by the IE Support, the 
expiration date will be displayed in the header of your IE Hub organization. When the expiration 
date is reached, the header indicates that your account has been cancelled resulting in a limited 
access to the IE Hub for all users of the IE Hub organization. 
With limited access to the IE Hub, the following is no longer possible:
• Creating IEM instances 
• Downloading any content (inclusive IEM configuration files)
• Purchasing apps
• Inviting new users
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With limited access to the IE Hub, the following is still available:
• List of existing IEM instances
• List of purchased apps in the "Library" section
• Download already purchased app licenses
• List existing users and delete users in the "User Management" section 
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Setting up the IEM 4
4.1 Setup steps

To deploy the IEM, you need access to the Industrial Edge Hub. After accessing and downloading 
the Industrial Edge Management OS (IEM-OS) from the Industrial Edge Hub, you must create an 
IEM instance. After creating the IEM instance, you run the downloaded Industrial Edge 
Management OS locally in a VM. This VM, including the Industrial Edge Management OS, 
enables the IEM. After activating the IEM-OS, the IEM gets installed as Industrial Edge 
Management App in the IEM-OS.
The following figure illustrates how the components are based on each other:

When you successfully install the IEM, you use the IEM to manage the on-premises Industrial 
Edge infrastructure.

Requirements for setting up the IEM
• A software is installed on the PC to extract zip-files, for example "7-Zip".
• A static IP address for the IEM which must not change after the IEM is set up.

You can configure the IEM network interface either with a static IP address or via using a DHCP 
server which then needs a static lease from the DHCP server.

• UEFI Boot is enabled in the VM.
• Minimum 16 GB RAM.
• In total, minimum 200 GB (2x100 GB) hard disk space.
• Ensure that the time setting on the host system is correct.
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• Do not enable the feature for virtualizing the clock in the VM.
• Do not install additional virtualization packages in the VM, for example VMware Tools or 

VMware Workstation or Oracle VirtualBox Guest Additions.
• Siemens recommends the following additional settings to raise security:

– VM is set up encrypted
– Trusted Platform Module (TPM) is enabled for the VM
You find information on how to enable these settings in the documentation of the 
virtualization environment itself from the Internet.

4.2 Downloading the Industrial Edge Management OS
You download the Industrial Edge Management OS (IEM-OS) for the VM from the IE Hub. The 
Industrial Edge Management OS, that is running in a VM, enables the IEM. 

Procedure
1. Sign into the IE Hub.
2. In the navigation, click "Download Software".

The "Download Software" screen is displayed.
3. In the "Initial Setup Tools" tab, click "Download" in the "Initial Setup VM - ISO" section.

The ISO image of the Industrial Edge Management is downloaded to the standard download 
folder of your Internet browser. The version of the IEM is included in the file name.
You run this ISO image later in the VM. 
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4.3 Creating an IEM instance and downloading the configuration file

Procedure
1. In the navigation menu in the IE Hub, click "IEM Instances".
2. Click "Create New IEM Instance".

The "Create IEM Instance" screen is displayed.

3. In the "Name" input field, enter the name of the instance.
The name of the instance must match the following criteria:
– Minimum 3 characters
– Only lowercase letters and numbers
– Must not start with a number
– Must be unique within your IE Hub organization

Note
Recommendation for name of the instance
Siemens recommends using a name for the instance that corresponds to the URL of the IEM 
that you later configure during the setup of the IEM. Use, for example, "iem" as name of the 
instance and "iem.my.domain.name.com" as URL of the IEM.

4. Optionally, enter a description for the IEM instance in the "Description" input field.
5. Click "Save".

The IEM instance is added to the IEM instance table. The configuration of the IEM instance is 
saved to the configuration file. 
Note
Changing the name of an IEM instance
You cannot change the name of an IEM instance. Instead, you must either create a new IEM 
instance or delete old IEM instances and recreate a new one. 

6. To download the IEM configuration file, click the  icon of the respective instance.  
The configuration file is downloaded to the standard download folder of your Internet 
browser.
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4.4 VMware Workstation

4.4.1 Creating the VM
After downloading the Industrial Edge Management OS, you import and install the IEM-OS in the 
virtualization environment. 
The following procedure describes the installation in the "VMware Workstation" virtualization 
environment. 

Requirement
The ISO image of the IEM is downloaded to the PC.

Procedure
1. Open "VMware Workstation".
2. Select the "File > New Virtual Machine" menu command. 

The "New Virtual Machine Wizard" screen is displayed.
3. Select the "Typical (recommended)" option as configuration type.
4. Click "Next".
5. Select the "Installer disc image file (iso)" option.
6. Click "Browse" and select the extracted "industrial_edge_management.iso" file.

7. Click "Next".
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8. From the "Guest operating system" options, select "Linux".
9. From the "Version" drop-down list, choose a 64-bit version of a Linux distribution, for 

example "Debian 10.x 64-bit".

10.Click "Next".
11.In the "Virtual machine name" input field, enter a name for the VM.
12.If necessary, choose a storage location for the VM on your PC by clicking "Browse". 
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13.Click "Next".
14.In the "Maximum disk size (GB)" input field, enter a maximum disk size for the VM on the host 

PCs physical disk. 
The disk is mandatory for the operating system and also stores IEM services. 
Siemens recommends a maximum disk size of 500 GB, a minimum of 100 GB is mandatory.

15.Select the "Store virtual disk as a single file" option.

16.Click "Next".
17.Click "Customize Hardware".
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18.For the memory amount allocated to the VM, choose a minimum of 16 GB.
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19.For the number of processors, choose minimum 2 processor cores for the VM.
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20.Click "Close".
21.Click "Finish".

The VM is created. 

4.4.2 Configuring the VM

Requirement
If you use a "Bridged" network connection for your VM, you need 1 additional network interface.

Note
USB network adapter
The following procedure describes the use of an USB network adapter as additional network 
interface. Proceed in the same manner for other additional network interfaces.
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Procedure
1. Select the created VM.
2. Click "Edit virtual machine settings".
3. In the hardware list on the left side, choose "Network Adapter".

The steps 5. to 10. describe the configuration when you use an USB network adapter for the 
network connection of your VM. This configuration is optional. You can also use a "NAT" 
network connection.
If you use a "NAT" network connection for your VM, go to step 8. 

4. On the right side under "Network connection", select "Bridged: Connected directly to the 
physical network".

5. Click "Configure Adapters".
The "Automatic Bridging Settings" screen is displayed.
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6. Activate only your connected USB network adapter.

7. Click "Ok".
8. Below the left navigation, click "Add".

The "Add Hardware Wizard" screen is displayed.

9. Select "Hard Disk" and click "Next".
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10.As virtual disk type, select "SCSI" and click "Next".

11.Select "Create a new virtual disk" and click "Next".
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12.In the "Maximum disk size (GB)" input field, enter a maximum disk size that is lower than the 
first disk size. 
The second hard disk is used for app images and containers in the IEMA, as well as for app's 
data storage.
The following figure shows a simplified representation of the data stored in each hard disk:

The size of the second hard disk depends on the apps and the apps sizes that you install in the 
IEMA. A minimum of 100 GB is mandatory. 
Note
IED backups via IE State Service
The IE State Service is used in the IEM for storing and restoring IED states. Ensure to choose 
an appropriate large hard disk space for the second hard disk (sdb) since the backup data of 
the IE State Service are being stored on this hard disk and cannot be changed afterwards. For 
more information on the IE State Service and IED backups, refer to the "Backups" section in 
the "Industrial Edge Management - Operation (https://
support.industry.siemens.com/cs/us/en/view/109804063)" manual.
You can later on add additional storage to the IEM by adding additional hard disks to the VM 
after setting up the IEM. Each additional added hard disk is used for storing the same type of 
data as the second hard disk (sdb) is used for.
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13.Select "Store virtual disk as a single file".

14.Enter a unique name for the created disk file. The disk file will be stored under the entered 
file name.

Setting up the IEM
4.4 VMware Workstation

Industrial Edge Management - Getting Started 08/22
66 Getting Started, 08/2022, A5E50177870-AK



15.Click "Finish".
The second hard disk is added to the hardware list in the left navigation. 

16.Click the "Options" tab.
17.In the navigation on the left side, choose "Advanced".
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18.Under the "Firmware type" section, select the "UEFI" checkbox.

19.Click "Ok".
The VM is configured.

Note
Installed open-vm-tools
If open-vm-tools are installed, the IEM does not start after a reboot. When you want to use open-
vm-tools, you must add the following configuration to the open-vm-tools config file 
("tools.conf"):
[guestinfo]
exclude-nics=docker*,veth*
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4.4.3 Installing the Industrial Edge Management OS

Requirement
UEFI Boot is enabled in the VM settings.

Procedure
1. Start the VM.

The "Siemens Industrial Edge" screen is displayed.

2. Select "Install System".
The "Install System" screen is displayed.

3. Select the 500 GB partition as installation destination.

4. Select "Install selected image".
If Trusted Platform Module (TPM) is not configured in the VM settings, a warning, indicating 
that no usable TPM is detecetd, is displayed. Otherwise, the TPM setup will occur.
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5. Select "Yes" to continue without TPM.  
Note
It is strongly recommended to use a virtual TPM to minimize risks of unauthorized access to 
the VM.

Note
No TPM enabled
If Trusted Platform Module (TPM) is not configured in the VM settings and you select "No", the 
installation of the Industrial Edge Management OS will not start. 
The installation of the Industrial Edge Management OS is starting.

6. Wait until the installation is completed.
7. When the installation is completed, reboot the VM by selecting "Reboot".

The VM is getting rebooted. 
Note
Changing boot order
When the "Siemens Industrial Edge" screen is displayed again after the reboot, you must 
change the boot order in the UEFI settings. Open the UEFI settings and set the disk at first 
place respectively the disk as boot disk in which the Industrial Edge Management OS has 
been installed.
After the reboot is finished, the welcome screen is displayed through which you configure the 
IEM-OS.   

The "Configuring the Industrial Edge Management OS (Page 103)" subsection describes how 
to configure the IEM-OS.

4.5 Oracle VirtualBox

4.5.1 Creating the VM 
The following procedure describes the installation in the "Oracle VirtualBox" virtualization 
environment. 
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Requirement
The ISO image of the IEM is downloaded to the PC.

Procedure
1. Open "Oracle VirtualBox".
2. Click "New".

The "Create Virtual Machine" screen is displayed.
3. In the "Name" input field, enter the name for the VM.
4. From the "Type" drop-down list, select "Linux".
5. From the "Version" drop-down list, select "Debian(64-bit)". 

6. Click "Next".
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7. For the memory amount allocated to the VM, set a minimum of 16 GB and click "Next".

8. For the hard disk, select "Create a virtual hard disk now" and click "Create".
9. For the hard disk file type, select "VDI (VirtualBox Disk Image)" and click "Next".
10.For the storage on the physical hard disk, select "Dynamically allocated" and click "Next". 
11.Choose a storage location for the hard disk file.
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12.For the hard disk size, set a maximum disk size for the VM on the host PCs physical disk.   

The disk is mandatory for the operating system and also stores IEM services. 
Siemens recommends a maximum disk size of 500 GB, a minimum of 100 GB is mandatory.

13.Click "Create".
The VM is created.
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4.5.2 Configuring the VM 

Requirement
If you use a "Bridged" network connection for your VM, you need 1 additional network interface.

Note
USB network adapter
The following procedure describes the use of an USB network adapter as additional network 
interface. Proceed in the same manner for other additional network interfaces.

Procedure
1. Select the created VM. 
2. Click "Settings".  
3. In the navigation on the left side, click "System". 
4. Click the "Processor" tab.
5. For the number of processors, choose minimum 2 processor cores for the VM.  
6. In the navigation on the left side, click "Storage". 
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7. Under "Controller: IDE", click "Empty".

8. On the right side, click the  icon. 
9. Click the "Choose/Create a Virtual Optical Disk" command.
10.Click "Add" and browse the ISO image of the Industrial Edge Management. 
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11.Click "Choose".
The selected ISO image is added under "Controller: IDE".

12.To add the second hard disk, select "Controller: SATA" and click the  icon. 
The "Hard Disk Selector" screen is displayed. 

13.Click "Create".
The "Create Virtual Hard Disk" screen is displayed.
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14.Select the "VDI (VirtualBox Disk Image)" check box and click "Next". 
15.Select the "Dynamically allocated" check box and click "Next".
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16.Select a maximum disk size that is lower than the disk size that you configured before. 

The second hard disk is used for app images and containers in the IEMA, as well as for app's 
data storage.
The following figure shows a simplified representation of the data stored in each hard disk:

The size of the second hard disk depends on the apps and the apps sizes that you install in the 
IEMA. A minimum of 100 GB is mandatory. 
Note
IED backups via IE State Service
The IE State Service is used in the IEM for storing and restoring IED states. Ensure to choose 
an appropriate large hard disk space for the second hard disk (sdb) since the backup data of 
the IE State Service are being stored on this hard disk and cannot be changed afterwards. For 
more information on the IE State Service and IED backups, refer to the "Backups" section in 
the "Industrial Edge Management - Operation (https://
support.industry.siemens.com/cs/us/en/view/109804063)" manual.
You can later on add additional storage to the IEM by adding additional hard disks to the VM 
after setting up the IEM. Each additional added hard disk is used for storing the same type of 
data as the second hard disk (sdb) is used for.
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17.Click "Create".
18.Click "Choose".

The second hard disk is added under "Controller: SATA".

19.In the navigation on the left side, click "Network".  
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20.If you use a bridged network connection, the following settings must be configured under the 
"Adapter 1" tab:
– Checkbox "Enable Network Adapter" selected 
– Attached to: "Bridged Adapter" 
– Name: Name of the additional network interface
– Adapter type: Intel PRO/1000 MT Desktop (8254OEM)
– Promiscuous Mode: Allow All
– MAC Address: Random MAC address
– Checkbox "Cable Connected" selected
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21.If you use a NAT network connection, the following settings must be configured under the 
"Adapter 1" tab:
– Checkbox "Enable Network Adapter" selected 
– Attached to: "NAT Network" 
– Name: Name of the NAT network
– Adapter type: Intel PRO/1000 MT Desktop (8254OEM)
– Promiscuous Mode: Allow All
– MAC Address: Random MAC address for the VM 
– Checkbox "Cable Connected" selected

For a NAT network connection,  the following settings must be also configured under the 
"Adapter 2" tab:
– Checkbox "Enable Network Adapter" selected 
– Attached to: "Host-only Adapter" 
– Name: Name of the host network manager 
– Adapter type: Intel PRO/1000 MT Desktop (8254OEM)
– Promiscuous Mode: Allow All
– MAC Address: Random MAC address for the VM 
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– Checkbox "Cable Connected" selected

22.Click "OK".
The VM is configured.

Creating a NAT network and a host network manager
When you use a NAT network connection for the VM and neither NAT network nor host network 
manager are available, proceed as follows to create a NAT network and a host network manager:
1. Click the "File > Preferences" command in the "Oracle VM VirtualBox Manager" screen.

The "Preferences" screen is displayed.
2. In the navigation, click "Network".
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3. To create a new NAT network, click the  icon. 
The NAT network is created.

4. Click "Ok".
5. Click the "File > Host Network Manager" command in the "Oracle VM VirtualBox Manager" 

screen.
The "Host Network Manager" screen is displayed.

6. To create a new host network manager, click "Create".
The host network manager is created.

7. To enable the host network manager, activate the "Enable" check box.

8. Click "Close".
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4.5.3 Installing the Industrial Edge Management OS 

Procedure
1. Start the VM.

The "Siemens Industrial Edge" screen is displayed.

2. Select "Install System".
The "Install System" screen is displayed.

3. Select the 500 GB partition as installation destination.

4. Select "Install selected image".
If Trusted Platform Module (TPM) is not configured in the VM settings, a warning, indicating 
that no usable TPM is detecetd, is displayed. Otherwise, the TPM setup will occur.
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5. Select "Yes" to continue without TPM.  
Note
It is strongly recommended to use a virtual TPM to minimize risks of unauthorized access to 
the VM.

Note
No TPM enabled
If Trusted Platform Module (TPM) is not configured in the VM settings and you select "No", the 
installation of the Industrial Edge Management OS will not start. 
The installation of the Industrial Edge Management OS is starting.

6. Wait until the installation is completed.
7. When the installation is completed, reboot the VM by selecting "Reboot".

The VM is getting rebooted. 
When the VM is rebooted, the "Siemens Industrial Edge" screen is displayed again.

8. Close and shut down the VM. 
9. After the VM is shut down, select the VM and click "Settings". 
10.In the navigation on the left side, click "System". 
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11.Select the "Enable EFI (special OSes only)" check box. 

12.In the navigation on the left side, click "Storage". 
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13.Under "Controller: IDE", select the ISO image.

14.On the right side, click the  icon. 
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15.Click the "Remove Disk from Virtual Drive" command. 
Under "Controller: IDE", "Empty" is displayed again.

16.Click "OK".
17.Start the VM.

The welcome screen is displayed through which you configure the IEM-OS. 

The "Configuring the Industrial Edge Management OS (Page 103)" subsection describes how 
to configure the IEM-OS.
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4.6 VMware ESXi

4.6.1 Creating and configuring the VM
The following procedure describes the installation in the "VMware ESXi" virtualization 
environment. 

Note
VMware ESXi V7.0 U2
The described procedure and displayed screenshots are related to VMware ESXi V7.0 U2.

Requirement
The ISO image of the IEM is downloaded to the PC.
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Procedure
1. Open the VMware ESXi server UI by entering the URL or IP address into an Internet browser.

The login screen is displayed.

2. Log in with the credentials set during the ESXi setup. 
The home screen of VMware ESXi is displayed. 
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3. In the navigation on the left, click "Storage".
4. Click "Datastore browser".

The "Datastore browser" screen is displayed.
5. On the left, select any datastore in which you want to upload and store the ISO image of the 

IEM.  
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6. To create a directory for the ISO image, click "Create directory". 

7. Enter a name for the directory and click "Create directory".
The ISO image you upload afterwards will be stored in this directory of the selected datastore.

8. Select the directory.
9. Click "Upload" and select the ISO image of the IEM.

The ISO image is being uploaded to use it in the VM.
10.Wait until the upload process is completed.

After the upload is completed, you can check that the ISO image has been uploaded to the 
directory.

11.Click "Close".
12.In the navigation on the left, click "Virtual Machines".
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13.Click "Create/Register VM".

The "New virtual machine" screen is displayed. 

14.Select "Create a new virtual machine" and click "Next".
15.In the "Name" input field, enter a unique name for the VM. 
16.From the "Compatibility" drop-down list, select the compatibility according to your setup.
17.From the "Guest OS family" drop-down list, select "Linux". 
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18.From the "Guest OS version" drop-down list, choose a 64-bit version of a Linux distribution, 
for example "Debian 10.x 64-bit".

Note
Debian GNU/Linux 10 (64-bit)
"Debian GNU/Linux 10 (64-bit)" is only available when selecting a compatibility of ESXi 
versions 6.7 or higher. The shown setup is done in V7.0 U2.

19.Click "Next".

Setting up the IEM
4.6 VMware ESXi

Industrial Edge Management - Getting Started 08/22
94 Getting Started, 08/2022, A5E50177870-AK



20.Select the datastore on which you want to store the VM. 

According to the IEM requirements, the datastore must have minimum 600 GB of free space 
for 2 virtual hard disks.

21.Click "Next".
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22.Add a second hard disk by clicking "Add hard disk". 
The first hard disk is mandatory for the operating system and also stores IEM services. 
The second hard disk is used for app images and containers in the IEMA, as well as for app's 
data storage.
The following figure shows a simplified representation of the data stored in each hard disk:

The size of the second hard disk depends on the apps and the apps sizes that you install in the 
IEMA. A minimum of 100 GB is mandatory. 
Note
IED backups via IE State Service
The IE State Service is used in the IEM for storing and restoring IED states. Ensure to choose 
an appropriate large hard disk space for the second hard disk (sdb) since the backup data of 
the IE State Service are being stored on this hard disk and cannot be changed afterwards. For 
more information on the IE State Service and IED backups, refer to the "Backups" section in 
the "Industrial Edge Management - Operation (https://
support.industry.siemens.com/cs/us/en/view/109804063)" manual.
You can later on add additional storage to the IEM by adding additional hard disks to the VM 
after setting up the IEM. Each additional added hard disk is used for storing the same type of 
data as the second hard disk (sdb) is used for.
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23.Specify the virtual hardware resources as follows:
– CPU: 2 cores
– Memory: 16 GB
– Hard disk 1: 500 GB

Disk Provisioning: Thin provisioned
– Hard disk 2: 100 GB

Disk Provisioning: Thin provisioned

Thin provisioned means that the storage on the physical hard disk is only allocated when 
needed. Otherwise, the disk's storage size remains small. 
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24.Expand "CD/DVD Drive 1" and select "Datastore ISO file".  

25.Select the previously uploaded ISO file and click "Select". 

26.Enable the "Connect at power on" check box.
By that, the ISO image wil be mounted when you start the VM.
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27.Select "VM Options".

28.Expand "VMware Tools" and disable the VMware tools scripts.

29.Expand "Boot Options".
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30.Under "Firmware", click the drop-down list and select "EFI" as boot firmware.

31.Enable UEFI secure boot by selecting the check box under "Enable UEFI secure boot".
32.Click "Next".

A summary of the VM settings is displayed. 
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33.Check again all provided details.
34.Click "Finish".

The VM is created and configured. 

4.6.2 Installing the Industrial Edge Management OS

Requirement
UEFI Boot is enabled in the VM settings.
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Procedure
1. Under "Virtual Machines" select the VM and start the VM by clicking "Power on".

The "Siemens Industrial Edge" screen is displayed.

2. Select "Install System".
The "Install System" screen is displayed.

3. Select the 500 GB partition as installation destination.

4. Select "Install selected image".
If Trusted Platform Module (TPM) is not configured in the VM settings, a warning, indicating 
that no usable TPM is detecetd, is displayed. Otherwise, the TPM setup will occur.

5. Select "Yes" to continue without TPM.  
Note
It is strongly recommended to use a virtual TPM to minimize risks of unauthorized access to 
the VM.

Note
No TPM enabled
If Trusted Platform Module (TPM) is not configured in the VM settings and you select "No", the 
installation of the Industrial Edge Management OS will not start. 
The installation of the Industrial Edge Management OS is starting.
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6. Wait until the installation is completed.
7. When the installation is completed, reboot the VM by selecting "Reboot".

The VM is getting rebooted. 
After the reboot is finished, the welcome screen is displayed through which you configure the 
IEM-OS.   

The "Configuring the Industrial Edge Management OS (Page 103)" subsection describes how 
to configure the IEM-OS.

4.7 Configuring the Industrial Edge Management OS

Procedure
1. In the welcome screen, select "Ok".
2. Select the localization settings as required.
3. Select the keyboard model as required.
4. Select the keyboard layout as required.
5. Select the default "None" keyboard variant.
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6. In the "Keyboard Settings", select "No" for ctrl-alt-backspace to kill xserver. 

An initialization is being performed. After the initialization process has been completed, an 
enhanced welcome screen is displayed.

The version of the IEM is displayed in the last row.
7. Select "OK".

The "Network Settings" screen is displayed.

Note
Multiple network interfaces via Oracle VirtualBox
If you set up the IEM via Oracle VirtualBox and with a NAT network connection inclusive host 
only adapter, 2 interfaces are displayed in this screen. In this case, configure both network 
interfaces as required.
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8. To start configuring your network settings, select the "ens33" network interface.
The following screen is displayed.

9. Select your network settings as required.
To use a DHCP network configuration, select "dhcp".
Note
DHCP IP address assignment
If you are using DHCP, ensure that always the same IP address is being used. Otherwise, if the 
IP address changes in a running IEM environment, the Industrial Edge Management will not 
run anymore.
When using DHCP, select "No" for obtaining the hostname via DHCP.

To use a static IP configuration for the VM, select "static". 
When you choose a static IP configuration, enter the following information:
– Static IP address
– IP netmask
– IP gateway
– DNS server
After you have configured your network settings, the "Network Settings" screen is displayed 
again.
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10.Select "Done".

The "Network Proxy Settings" screen is displayed.
11.Select "No" for the configuration of a proxy.  

To use a proxy server, you can set and configure a proxy server in the 
Industrial Edge Management UI.
The "Timezone Settings" screen is displayed.

12.Select the timezone as required.
The "Date/Time Settings" screen is displayed.

13.Use an NTP server by selecting "NTP".
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14.Select "Add server".
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15.Enter the NTP server.

A flawless operation of the Industrial Edge Management and Edge Devices require time 
synchronization of the Industrial Edge Management and Edge Devices. To properly 
synchronize the time on the Industrial Edge Management and Edge Devices, minimum 1 NTP 
server is mandatory. 
After you have entered the NTP server, the NTP server is added to the server list.

If you want to add further NTP servers, select again "Add server" and enter the next NTP 
server.
All entered NTP servers are added to the server list.
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16.After adding your NTP servers, select "Done".
The "Autostart Settings" screen is displayed.

17.To lock the settings, select "Disable". To allow reconfiguration of the setup, select "Enable".
Note
Reconfiguration of the setup
After you have set up the IEM-OS, you can recall and reconfigure the setup by hotplugging the 
installation medium. For that, select "Enable".
The setup is being performed.
When the setup is completed, the following screen is displayed.

18.Select "Ok".
The VM is getting rebooted. This may take up to 10 minutes. When the reboot is finished, the 
login screen is displayed.

The configuration of the IEM-OS is completed.
Note
NAT network connection in Oracle VirtualBox
In case you use Oracle VirtualBox and a NAT network connection inclusive host only adapter, 
2 IP addresses are displayed. To set up the Industrial Edge Management, use the second 
displayed IP address ("enp0s8" network interface).
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4.8 Activating & Installing the Industrial Edge Management

4.8.1 Activating the Industrial Edge Management
To activate and install the IEM, use an Internet browser on a client that is in the same network 
and subnet as the VM. 

Procedure
1. Enter the IP address of the VM respectively of the Maintenance UI in the HTTPS protocol into 

an Internet browser, for example "https://178.123.11.54".
The IP address is shown in the login screen in the VM.
A certificate warning is displayed.

2. Click "Advanced".
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3. To connect to your Maintenance UI, click "Proceed to <IP address>".

The "Activate IEM Instance" screen is displayed.
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4. In the "Onboarding Configuration" section, click "Browse" and select the downloaded IEM 
configuration file that you created in the Industrial Edge Hub.
This IEM configuration file contains a key that is just valid for 1 hour. After 1 hour, the 
configuration file is expired and you have to download a new IEM configuration file.

5. In the "Admin Accounts" section, create an admin user for the IEM-OS by entering the email 
address and password of the admin user.
The password must meet the following criteria:
– Minimum 8 characters
– Minimum 1 upper case letter
– Minimum 1 special character
– Minimum 1 number
The following characters are recognized as special characters: ! @ # $ % ^ & * . ( ) _ +
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6. If you want the admin user for the IEM-OS to be also the admin user for the IEM, activate the 
"Use same credentials for IEM" check box.

7. If you want to create a different admin user for the IEM, disable the "Use same credentials for 
IEM" check box and enter the email address and password of the admin user for the IEM in the 
"IEM Email" and "IEM Password" input fields. 
Creating an admin account for the IEM-OS and for the IEM is mandatory.
Note
Resolved DNS entries
If you want to use resolved DNS entries for domain names to access the IEM, ensure to resolve 
the DNS entries in the cloud or configure the local DNS server. Before you create the IEM-OS, 
add the DNS server addresses to the network settings by clicking "Settings" and then clicking 
the edit icon under the "LAN" tab. 
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8. After configuring the settings, click "Next".
The "Certificate" tab is displayed.

9. In the "Common Name" input field, enter the Fully Qualified Domain Name (FQDN).
Typically, the FQDN is composed of the host domain name. The FQDN is used to generate a 
rootCA on the IEM-OS for the following purposes:
– Generating certificates to configure the Edge Device's reverse proxy server TLS settings.
– Generating certificates to configure the IEM's reverse proxy server TLS settings if the IEM 

is set up with default settings. 
– Generating certificates to configure the IEM-OS's reverse proxy server TLS settings.
The "Common Name" input field is mandatory, should not have multiple "@" symbols and 
must not exceed 253 characters. 
The other input fields are optional.

10.Before activating the IEM instance, configure the system settings respectively ensure that 
your settings are correct by clicking "Settings".
You can configure the following settings:
– Network 
– Proxy server 
– Docker network
– NTP server
You find more information on the system settings in the "Settings (Page 123)" subsection.
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11.Click "Activate".
When the activation of the IEM instance was successful, an according screen is displayed.

12.Click "OK".
You will be redirected to the "Sign in" screen.

13.Sign in with the admin user for the IEM-OS that you created during the setup.
The "Edge Management System Configuration" screen is displayed. 

4.8.2 Installing the Industrial Edge Management
The Industrial Edge Management can be configured to use custom certificates or certificates 
from the IEM itself during the setup.

Note
In the following, the term "cluster" is a synonym for the IEM-OS.
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Procedure
1. To use self-signed certificates by the IEM itself, disable the "Custom Certificate" check box in 

the "Edge Management System Configuration" screen and go to step 11.  
Note
Industrial Edge Management App version
The version of the Industrial Edge Management App, in the UI displayed as "Edge 
Management" app, that you install is displayed above the "Custom Certificate" check box.

Note
Edge Management URL
The URL of the Management UI of the IEM is displayed at the bottom of the screen.

Note
Importing certificates after the setup
When you do not use your own certificates but the certificates from the IEM, you cannot 
import your own certificates after the setup of the IEM anymore.

2. If you want to use your own certificates, enable the "Custom Certificate" check box.
The IEM and its components require full certificate chains with root-CA, that means that the 
used certificates must be certificated and trusted by a higher certificate instance. These 
certificates are used to setup the IEM App with HTTPS communication. You find more 
information on the certificate requirements and the certificate chain in the "Certificate 
requirements (Page 132)" subsection.
The private keys and certificates must be uploaded in the *.pem format, for example 
"portal.key" and "portal.crt" files. 
You must select certificates for the IEM and for the Registry server. 

3. In the "Edge Management SSL Key" field, click "Browse" and select your private key for the IEM. 
4. In the "Edge Management SSL Certificate" field, click "Browse" and select your certificate for 

the IEM.
When you use 2 different certificates with different domain names, select 1 for the IEM and 
1 for the Registry server. 
When you use wildcard certificates issued for the "*.<domain.name>" domain, you can use 
the certificates for both the IEM and the Registry server. 
When you use SAN certificates with 2 different domain names, you can use the certificates for 
both the IEM and the Registry server. 
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5. In the "Edge Management URL" input field, enter the FQDN of the IEM that you want to use 
to open the IEM, for example "iem.my.domain.name.com". 
The "Edge Management URL" is needed for the API and the UI of the IEM. If you use resolved 
DNS entries for domain names, you can use the URL of the IEM to access the IEM by entering 
the domain name instead of the IP address. 
Note
Avoid warnings
Add the IP address into the SAN field. By that, the IEM can be opened without warnings by 
systems which cannot resolve the DNS.

Note
Multiple DNS servers
If you are using multiple DNS servers, ensure to resolve the URL of the IEM in each DNS server. 
Otherwise, connection problems can occur during the access to the IEM. 
The "Edge Management URL" text field is being adapted according to your configuration.
When you enter the URL of your IEM, the "Public Trusted" check box is enabled. 

6. In the "Registry SSL Key" field, click "Browse" and select your private key for the Registry server. 
7. In the "Registry SSL Certificate" field, click "Browse" and select your private certificate for the 

Registry server.
Adding your private certificates and keys is mandatory when you do not use the created and 
self-signed certificates by the IEM itself.

8. In the "Registry URL" input field, enter a FQDN for the Registry server, for example "iem-
registry.my.domain.name.com". 
Note
Registry URL
Use for the "Registry URL" input field an own FQDN like for the "Edge Management URL" input 
field.
The "Registry URL" is needed for using Docker images of Edge Apps. 

9. If the selected certificates are wildcard or SAN certificates and thus signed by a public CA, 
activate the "Public Trusted" check box. 
If the certificates are signed by a public CA, you do not have to manage certificates for other 
components, for example the IE App Publisher or Edge Devices, to accept and use your 
certificates.
You can only enable this during the IEM setup and you cannot change this setting afterwards.
Note
Public CA
As long as the "Public Trusted" check box is not enabled, the custom certificate chain of trust 
is also transferred as trusted root certificate to the IEDs. 

10.If the certificates are not public trusted, deselect the "Public Trusted" check box.
In that case, you must import and accept the full chain certificates with root-CA for each other 
component in Industrial Edge.
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11.Click "Next".
The "System Services" tab is displayed. 

In this screen, you can change, if needed, the default installation configurations of IEM 
Services. 

12.Select an IEM Service on the left.
The version of the IEM Service that is being installed is displayed below the app icon.

13.Ensure that the available resource files in the "Resources" tab are activated.
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14.If needed, you can change the default installation configuration in the "Configurations" tab.
For the IE State Service, you can enable the monitoring service in the "Configurations" tab.
You find the procedure on enabling the monitoring service and further information on the 
service under "Backups > Industrial Edge State Service > Configuration" in the "Industrial Edge 
Management - Operation (https://support.industry.siemens.com/cs/us/en/view/
109804063)" manual.
Note
Except the IE State Service, Siemens recommends not changing the installation 
configurations.

15.Ensure that for each IEM Service the available resource files in the "Resources" tab are 
activated.
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16.Click "Next".
The "Information" tab is displayed. 

The "IEM Cluster Network" section is editable, the "Configuration", "Network" and "Storage" 
sections are non-editable and are just displayed for your information.

17.If needed, edit the "Service Network" and the "POD Network" sections.
The networks are needed for internal services. These network ranges must not overlap the 
LAN network in which the IEM is installed and both network ranges must not overlap each 
other.
The "Netmask" entry indicates a network subnet and is the subnet in the Classless Inter-
Domain Routing (CIDR) format, for example "67.67.0.0/12".
Note
IEM Cluster Network settings
Siemens recommends not changing these settings.
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18.Click "Create Cluster".
You will be redirected to the Maintenance UI.  
The "Create cluster" screen is displayed.

The IEM-OS is being created automatically. This process takes approximately 15 minutes.
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19.When the "Cluster created successfully" message is displayed, click "Ok".

Automatically, the Industrial Edge Management App is being installed. Via the app, you open 
the Management UI, the central UI of the IEM.

20.Wait until the Industrial Edge Management App is installed.
You can check the installation progress by clicking the  icon. When the installation was 
successful, the "Edge Management" app is displayed in the "Home" section of the 
Maintenance UI.

Note
Installation of the IEM App
When the IEM App is installed, automatically few images and containers are getting 
downloaded to use the IEM App. Depending on the Internet speed, the download of these 
images and containers takes approximately 10 minutes.
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Note
Automatic installation of IEM Services
With upcoming releases, several IEM Services, for example the IE State Service and the IE App 
Configuration Service, are also getting installed automatically. You can check which IEM 
Services are getting installed automatically, and also the installation progress respectively 
status of the IEM Service, by clicking the  icon.

4.8.3 Settings

4.8.3.1 Settings
You can edit the following settings before you install the Industrial Edge Management:
• Network settings
• Proxy settings
• Docker network settings
• NTP settings
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4.8.3.2 Editing network settings

Procedure
1. In the "Activate IEM instance" screen, click "Settings".

The "Settings" screen is displayed. 

In the "LAN" tab, the configured network settings are displayed.
2. To edit the network settings, click the  icon.

The "Configure NIC" screen is displayed. 
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3. Configure the IP address and the DNS server as required, either automatically through DHCP 
server or through static information.
Note
Resolved DNS entries
If you want to use resolved DNS entries for domain names to access the IEM, ensure to resolve 
the DNS entries in the cloud or configure the local DNS server. Before you create the IEM-OS, 
add the DNS server addresses to the network settings. 

4. If you want to use a specific MAC Address, activate the "Change Mac Address" check box and 
enter the desired MAC address.

5. Click "Save".

4.8.3.3 Setting up a proxy server
With the use of a proxy server, the admin of the IEM (and of Edge Devices) can add, edit and 
remove proxy rules to redirect specific data traffic. The admin can also disable redirection of 
specific data traffic through the proxy.
App developers do not need to implement their own proxy settings. The proxy settings described 
in this procedure apply for all IEM components.
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Procedure
1. Click the "Proxy" tab.

2. To use a proxy server, click the "Use a proxy server" check box.
The input fields for the proxy server settings are enabled.

3. Enter the IP address and the corresponding port of the proxy server in the according input 
fields. 

4. If needed, enter username and corresponding password in the according input fields in case 
of an additional authentication for the proxy server. 
When authentication is required, the password must match the following criteria:
– The password must start with an alphabetic character
– The password must not contain complex characters, such as \ . * " 
– The password must not be longer than 21 characters 
The settings apply for HTTP and HTTPS proxy servers.
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5. Click "Next".
The "No Proxy" tab is displayed. 

In the "No Proxy" tab, add all the IP addresses which shall be accessed directly (without use 
of proxy). 
By default, several no proxy addresses are listed which are required by the IEM.

6. If you want to add a further IP address which shall be accessed directly, enter the IP address 
inclusive subnet, for example <IP/32>, or the domain of the no proxy address in the "IP" input 
field and click the  icon.  
The address is added to the no proxy list.
When you use a proxy server to connect to the IEM after you have installed the IEM, you must 
add the Industrial Edge Management URL and the Industrial Edge Management App registry 
URL to the no proxy address list. Otherwise, several errors can occur when you use the IEM. 
Also, ensure adding the proxy server address to the no proxy list. This is required for 
supporting transparent proxy feature and for supporting HTTP proxy aware IEM extensions 
at same time. 
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7. Click "Next". 
The "Custom Port" tab is displayed. 

In the "Custom Port" tab, you configure ports for apps which use the configured ports for 
outgoing communication through the proxy on HTTPS or HTTP protocols.
By default, several ports are listed which are required by the IEM.
Note
Default no proxy addresses and ports
The default no proxy addresses and ports are essential for running the IEM and cannot be 
deleted.

8. If you want to add a further port, select the required protocol from the "Protocol" drop-down 
list and enter the required port.

9. To add the port, click the  icon.
The port is added to the port list.

10.To add the proxy settings, click "Configure".
11.Confirm the proxy settings by clicking "Ok".

The proxy settings are saved. 
Note
Setting up a proxy server after IEM installation
You can also configure and update the proxy settings after the IEM installation. In the 
Maintenance UI, navigate to the "Settings > Connectivity > Proxy" section and set the proxy 
settings. 
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4.8.3.4 Configuring the Docker network
By default, the Docker server creates and configures the host system's network interface called 
docker0. The Docker server configures the docker0 network with an IP address, a netmask and 
an IP allocation range. The default docker0 network range is 172.17.0.0/16. If this network 
range conflicts with the existing system's network configuration, certain services do not work 
and you are not able to access the Maintenance UI in a browser. 
To prevent this scenario, you can configure the docker0 network range as described in the 
following.

Procedure
1. In the "Settings" screen, click the "Docker Network" tab.

2. In the "IP address" input field, enter the IP address that you want to use for the docker0 
network.
The IP address of the docker0 network is the start of the docker0 network.  

3. In the "Netmask" input field, enter the subnet mask of the docker0 network.

4. To save the settings, click "Configure".
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4.8.3.5 Downloading system logs

Procedure
1. Click the "System" tab.

2. Click the "System Logs" tile. 
The log file is being downloaded to the standard download folder of your Internet browser.

4.8.3.6 Adding an NTP server
A flawless operation of the Industrial Edge Management and Edge Devices require time 
synchronization of the Industrial Edge Management and Edge Devices. To properly synchronize 
the time on the Industrial Edge Management and Edge Devices, an NTP server is mandatory.
If you already have added an NTP server during the configuration of the Industrial Edge 
Management OS, you can skip this procedure.
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Procedure
1. Click the "System" tab.

2. Click the "NTP Server" tile.
The "NTP Server" screen is displayed.

If you have added an NTP server during the configuration of the Industrial Edge Management 
OS, the NTP server is displayed in the server list.

3. If you have not added minimum 1 NTP server or you want to add an other NTP server, enter 
the NTP server in the "Server Name" input field.

4. To add the NTP server, click the plus icon. 
The NTP server is added to the server list.
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5. By clicking the  icon, you select the NTP server as preferred NTP server which signals the 
NTP service to always select this NTP server as synchronization source, in case the server is 
available. 
Preferred NTP servers are marked with .

6. By selecting the "Enable IEM as NTP server" check box, the NTP services in the IEM serve as 
an NTP server for other NTP clients, for example Edge Devices. 
This option removes the dependency that an NTP server must be configured in the local 
automation network and serves Edge Devices which cannot access any global or local servers 
within the local network. 

7. By selecting the "Use the IEM NTP settings for the IED" check box, Edge Devices that are 
getting connected to this IEM use the same preferred NTP server for time synchronization. 
Note
Selecting NTP server
You can just select either the "Enable IEM as NTP server" or the "Use the IEM NTP settings for 
the IED" at the same time. 

8. By selecting the "Auto Restart NTP" check box, the automatic restart of NTP services is 
enabled.  
By default, the "Auto Restart NTP" check box is enabled. If, due to any kind of reason, NTP 
services in the IEM have stopped and the "Auto Restart NTP" check box is enabled, the NTP 
monitoring service will automatically restart the NTP services. 
Note
Data loss due to leap in time
If NTP services in the IEM have stopped and the automatic restart of NTP services is enabled 
via this option, a leap in time might occur after automatically restarting NTP services. Be 
aware that time series based applications might be affected by this leap in time resulting in 
losing data. If you do not want this risk of losing data, disable the "Auto Restart NTP" check 
box.

9. Click "Submit". 

4.8.4 Certificate requirements
Industrial Edge certificates require the following mandatory fields to be configured:
• Common Name (CN)
• Subject Alternative Name (SAN)
If you set up the IEM using custom certificates, ensure that these mandatory fields are 
configured in the provided certificates. Moreover, the provided information must fit into the root 
or intermediate CA’s policies.
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Beside these mandatory fields, you can also provide optional information. The following fields 
are optional:
• Country Name (C)
• State or Province Name (S)
• Organization Name (O)
• Organization Unit (OU)

Checked certificate properties
Currently, the following properties are checked upon import of the certificate:
• CA certificate existence
• Key file validity 
Some properties are not checked and need to be checked by the user manually:  
• All necessary fields are filled
• Validity of certificate chain (your certificate – intermediate certificate – root-CA certificate) 
• Corresponding of server names in the certificates to the used DNS names

Certificate chain
The used certificates require to contain the whole certificate chain in the *.crt file.
The certificate chain starts with your certificate followed by intermediate certificates and ends 
with the root-CA certificate. The issuer of any certificate in the certificate chain must be equal to 
the subject of the next certificate, ending with the root-CA certificate where subject and issuer 
are equal. 

Up to IEM V1.2, line breaks in the certificate text files must be \LF only (Linux style). \CR\LF 
(Windows style) and \CR (Mac style) are not supported.
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4.9 Installing configurators
Configurators are essential for using the "IE Databus" System App and some other special apps. 
Apps that are being configured by a configurator and that are installed on Edge Devices are also 
considered as runtime apps. The configurators can configure and launch each decentrally 
installed runtime app on your Edge Devices. To use these runtime apps, the respective 
configurator must be installed in the Maintenance UI of the IEM. 
Configurators are for example: 
• IE Databus Configurator
• IE Cloud Connector Configurator
• SIMATIC S7 Connector Configurator
More configurators will follow with further IE releases.
The following procedure describes the installation of the "IE Databus Configurator". To install 
other configurators, proceed in the same manner.

Note
Configurators documentation
You find more information on the functionalities and the operation of the configurators in the 
manual of each configurator in SIOS (https://support.industry.siemens.com/cs/products?
mfn=ps&pnid=26128&lc=en-WW).  
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Procedure
1. In the navigation menu of the Maintenance UI, click "Catalog".
2. Click the "IE Databus Configurator" app.

The "Install App" screen is displayed.

The app version you install is displayed below the app icon.
3. Ensure that the available resource file is activated.
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4. Click either "Install Later" or "Install Now".  
"Install Now" installs the app immediately. When you click "Install Later", select an installation 
time. 
Note
Installation date and time
When you select "Install Later", a calendar and the local system time is displayed for selecting 
the installation date and time.

5. To check the installation status, click the tasks icon in the top right corner.

6. Wait for the app to be installed. 
7. Before you continue, install the other available configurators in the same manner and wait 

until all configurators are installed and available in the Maintenance UI.
Note
Using the configurators
By clicking the tile of a configurator after it is installed, the configurator will be launched with 
an error. To use the configurator, the respective runtime app must be installed on your Edge 
Devices. Afterwards, you can use the configurator and launch the respective app under "Data 
Connections" in the Management UI. 
You find the procedure on installing apps in the "Installing an app (Page 175)" subsection.

4.10 Adding a relay server
When your Edge Devices are placed in your plant network that is separated for example by NAT 
Gateway from the control plane network in which the IEM is running, the direct access from the 
control network is not possible. Normal operation is still possible, as the Edge Devices always 
initiate the communication from their side. For direct access through "remote access", for 
example for debugging on Edge Devices, a relay server is needed. The Edge Devices in the plant 
network establish the connection to the relay server. The IEM can act as a relay server for your 
Edge Devices. For that, you must add the IP address of the IEM server. Afterwards, you can use 
the "remote access" through the IEM after activation. Only 1 relay server per IEM is allowed. 
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Procedure
1. When the Industrial Edge Management App and the configurators are installed, open the 

Management UI by clicking the "Edge Management" app. 
Alternatively, you open the Management UI by entering the URL of the IEM that you entered 
during the setup of the IEM-OS into an Internet browser, for example 
"iem.my.domain.name.com".
The login screen of the Management UI is displayed.

2. Click "Sign in".
The "Sign in" screen is displayed.
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3. Log in with the admin credentials that you configured during the setup of the IEM-OS.
The home page of the Management UI is displayed.

4. In the navigation menu, click "Admin Management".
The "Dashboard" screen of the Admin UI is displayed.

5. In the "Relay Servers" section, click "More Info".

The "Relay Servers" screen is displayed.
6. Click "Add".

The "Add Relay Server" screen is displayed.
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7. In the "Domain Name" input field, enter either the IP address or the DNS name of your IEM.
If you are using an IP-based IEM, enter the IP address of the IEM or a DNS name which is 
resolved to this IP address. 
If you are using a DNS-based IEM, enter the DNS name of the Industrial Edge Management 
App. 

8. In the "IP Address" input field, enter the IP address of your IEM.

Note
Usable Ports
These ports are being used only internally in the IEM. 

Note
VM IP address
You get the IP address of your VM from the login screen in the VM. 

9. Click "Add".
The relay server is added to the relay servers list. The setup of the IEM is completed. 
In the next sections, you find the procedure on how to connect Edge Devices to the IEM and 
on how to install apps onto them.
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Connecting an Edge Device 5
When you add an Edge Device in the Management UI, an Edge Device configuration file is 
created. You need this configuration file to successfully onboard your Edge Device in the IEM.

Requirements for adding an Edge Device
• The Edge Device is switched on.
• The Edge Device is connected to the local network.

5.1 Creating the Edge Device configuration file

Procedure
1. Open and log into the Management UI.
2. Navigate to the "Edge Devices" menu item.
3. In the "Edge Devices" screen, click "New Edge Device".

The "New Edge Device" screen is displayed.
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4. In the "Device" tab, enter all the required information according to the 
"New Edge Device ‑ Parameters" subsection.
Note
Synchronizing Edge Device Types
Only Edge Device Types that are synchronized with the IEM are available. The admin of the 
IEM can synchronize Edge Device Types with the IEM under "Admin Management > Device 
Catalog". You find further information on synchronizing Edge Device Types in the "Admin UI 
> Device Catalog" subsection in the "Industrial Edge Management - Operation" manual.
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5. After entering all required information, click "Next".

The "Network Interface" tab is displayed. 
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6. To configure the network interface settings for the Edge Device, click the  icon under the 
"Network Interface" section. 
Configuring the network interface settings for the Edge Device is optional. It depends on the 
Edge Device Type whether you must configure the network interface settings or not. If you 
do not need to configure the network interface settings, the Edge Device is using the default 
network interface settings provided by the Device Builder. In this case, you can proceed 
configuring an NTP server and a Docker network as described from step 11 ongoing. 
Note
You can find the available type of the network interface connection of the respective Edge 
Device Types in the Edge Device Type details under "Admin Management > Device Catalog". 
Contact the Device Builder or check the documentation of that Edge Device Type to know, if 
you must configure the network interface settings for the Edge Device or not.
The "Add Network Interface" screen is displayed.
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Depending on the Edge Device Type, the Edge Device Type and its network interfaces are 
displayed at the top of the screen.

7. Enter the network interface settings of the Edge Device according to the 
"New Edge Device ‑ Parameters" subsection.  

8. If required, set up a Layer 2 network access on this Edge Device under the "Layer 2 (L2) for 
Apps" section.
Setting up a Layer 2 network access for apps is optional. You find more information on the 
Layer 2 network access for apps in the "Layer 2 network access" subsection. When setting up 
a Layer 2 network access, enter the required information according to the 
"New Edge Device ‑ Parameters" subsection.  
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9. When finished, click "Add".
The configured network interface is added. 
If you have entered a MAC address, the MAC address is displayed in the table.

If you have selected an Ethernet label, instead of the MAC address, the Ethernet label is 
displayed in the table.

You can add more than 1 network interface by clicking the  icon again and adding another 
network interface. If the maximum number of network interfaces is reached, the  icon is 
disabled.
If you have configured a Layer 2 network access, the L2 check mark is activated which means 
that the L2 network access is enabled. 

If you click again the  button to add another network interface, the "Layer 2 for Apps (L2)" 
section displays "Already configured". You can just configure 1 Layer 2 network access per 
Edge Device. 
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10.Select 1 Network Time Protocol (NTP) server you want to use for this Edge Device under the 
"NTP Server" section.
When you already have configured an NTP server during the setup of the 
Industrial Edge Management or when you added an NTP server in the Maintenance UI 
settings and selected the "Use Same NTP On IED" check box, the NTP servers are displayed 
under the "NTP Server" section . 

If you want to use an other NTP server, enter the NTP server in the "Server Name" input field, 
click the plus icon and select the newly added NTP server.

Note
Time synchronization of the Industrial Edge Management and Edge Devices
A flawless operation of the Industrial Edge Management and Edge Devices require time 
synchronization of the Industrial Edge Management and Edge Devices. To properly 
synchronize the time on the Industrial Edge Management and Edge Devices, an NTP server 
is required. Either use the default configured Debian NTP servers which will be used once you 
connect the PC, on which the Industrial Edge Management is running, with the Internet. Or, 
when you operate the Industrial Edge Management and Edge Devices disconnected from the 
Internet in your local network, provide an own NTP server to which the 
Industrial Edge Management and Edge Devices must be able to connect to.
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11.If you want to change the default Docker network, click the "Docker Internal Network" check 
box.

By default, the Edge Device contains 2 Docker networks, 1 for the proxy-redirect and 1 for the 
docker0 interface (that you create via the "IP Address" input field). When you install an app 
which creates a new Docker network on the Edge Device, the Docker network of the installed 
app must not overlap the Docker networks of the Edge Device and need free Docker network 
IP ranges on the Edge Device. 
By default, the docker0 interface starts with 172.17.0.0. Using a different docker0 interface 
is optional.

12.In the "IP Address" input field, select the IP address of the docker0 interface you want to use 
for the Edge Device.
 The IP address of the docker0 interface is the start of the docker0 interface. The subnet mask 
is not configurable.

13.Click "Next".
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14.In the "Proxy" tab, enter, if needed, all required proxy information according to the 
"New Edge Device ‑ Parameters" subsection.

15.Click "Create".
A configuration file named "device-<deviceID>" is downloaded to the standard download 
folder of your Internet browser. 
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5.2 Onboarding the Edge Device

Procedure
1. Open the Edge Device UI by entering the IP address of the Edge Device in HTTPS protocol into 

your Internet browser, for example "https://192.168.80.123".
A certificate warning is displayed.

2. Click "Advanced".
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3. Click "Proceed to <IP address>".

The "Activate Edge Device" screen is displayed.

4. Click "Browse" and select the created Edge Device configuration file.
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5. Click "Settings" to configure the following settings:
– Network settings
– Proxy settings
– Docker network settings
– System settings
You find the procedure on how to configure each setting in the "Settings" subsection.

6. After configuring the settings, click "Activate".
The Edge Device is being connected to the IEM. When the connecting process was successful, 
an according message is displayed.

7. Click "Ok".
You will be redirected to the Edge Device UI.
Note
Connection successful
When the Edge Device is connected successfully to the IEM, the status indicator at the top of 
the Edge Device tile in the IEM switches to green and the IP address of the Edge Device is 
displayed under the name of the Edge Device.

8. Sign in with your email address and password that you have entered in the "New Edge Device" 
screen.
The home page of the Edge Device UI is displayed.

Note
When you onboard a SIMATIC IPC Edge Device, you also have the possibility to onboard it via a 
USB flash drive. You find the procedure and additional information on this procedure in the 
"SIMATIC IPC Industrial Edge Device - Operation (https://support.industry.siemens.com/cs/us/en/
view/109803878)" manual.
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5.3 New Edge Device - Parameters

Device
Parameter Description
Edge Device 
Type

Device type of the Edge Device you want to onboard, for example SIMATIC IPC227E

Edge Device 
Name

• Unique domain wide name of the Edge Device
• Must contain 3 - 64 characters

Edge Device 
Username

Valid email address of the user for signing into the Edge Device

Edge Device 
Password

• Password for signing into the Edge Device
• Minimum 8 characters
• Minimum 1 upper case letter
• Minimum 1 special character
• Minimum 1 number
• The following characters are recognized as special characters: 

! @ # $ % ^ & * . ( ) _ +
Edge Device 
Confirm Pass‐
word

Confirm Edge Device password

Network Interface
Parameter Description
Gateway Inter‐
face

• In a typical setup, the IEM and cloud access are reachable via default route and 
default gateway. In this case, enable the "Gateway Interface" check box for the 
network interface, for example either X1 or X2, to which the default router and the 
default gateway is connected to

• If this default network interface is not reachable or the connection to the interface 
fails, a connection to another network interface is attempted to be established

MAC Address • Depending on the Edge Device Type, either "MAC Address", "Ethernet Label" or 
both is available

• If the Edge Device Type requires a MAC address, this field is enabled
• In case both "MAC Address" and "Ethernet Label" are available, select 1 of them you 

want to use
• Enter the MAC address of the network interface which is currently configured
• Use colons as separations
• Example MAC address: 00:0c:29:82:3f:81
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Parameter Description
Ethernet Label • Depending on the Edge Device Type, either "MAC Address", "Ethernet Label" or 

both is available
• If the Edge Device Type requires an Ethernet label, this field is enabled
• In case both "MAC Address" and "Ethernet Label" are available, select 1 of them you 

want to use
• Select the network interface you want to use to connect the Edge Device to the IEM

DHCP • Enable or disable IP address assignment through DHCP
• If this check box is selected, the IP address is assigned through DHCP  
• When the check box is disabled, static IP address assignment is used

IPv4 • Only enabled when DHCP is disabled
• IP address of the Edge Device in the network 
• Input of the IP address is mandatory when DHCP is disabled 

Netmask • Only enabled when DHCP is disabled 
• Subnet mask in the "255 255 0 0" format, for example
• Input of the subnet mask is mandatory when DHCP is disabled 

Gateway • Only enabled when DHCP is disabled
• IP address of the gateway 
• Input of the IP address is mandatory when DHCP is disabled

Primary DNS • Primary DNS server address 
• Input of the DNS server address is optional

Secondary DNS • Secondary DNS server address 
• Input of the DNS server address is optional

Start IP Address • L2 network access is optional
• Start of the L2 network access IP address range
• Number in the last octet must be even
• Input of Start IP Address is mandatory for L2 network access usage

Netmask • Netmask defines the section in which the IP addresses are located
• Input of netmask is mandatory for L2 network access usage

IP Address 
Range

• Length of the IP address range for usage of Edge Apps with direct L2 network access
• Minimum IP address range is 2, maximum range is 256
• Valid displayed IP address range depends on last number in Start IP address, for 

example:
– If last number of Start IP address is 16: 1, 2, 4, 8 and 16 is available
– If last number Start IP address is 172: 1, 2 and 4 is available 
– If last number Start IP address is 0: 1, 2, 4, 8, 16, 32, 64, 128 and 256 is available

• Input of IP address range is mandatory for L2 network access usage
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Note
MAC address and Ethernet label
It depends on the Edge Device Type which input type is required for the network interface 
settings, whether MAC address or Ethernet label. The Edge Device builder by himself forces 
which type is required and must be provided to onboard the Edge Device to the IEM.

The parameters in the "Layer 2 for Apps (L2)" section and thus the configured Layer 2 network 
access is independent of the "DHCP" and "Gateway Interface" configuration. 
Ensure that the Edge Device IP addresses and the configured L2 network access configurations 
do not collide with addresses of other devices in the network.

Note
IP address and broadcast IP address of subnet
Do not use the IP address and the broadcast IP address of the subnet defined by the netmask for 
the configured IP address range.

For more information regarding the configuration of Docker IP address ranges, check the official 
Docker documentation (https://docs.docker.com/network/macvlan/).

Proxy
Parameter Description
Host • IP address and port of the proxy

• Input in the format <IP>:<PORT>
• Proxy host address is optional

Protocol Transport protocol of the proxy server
User Username for authentication on the proxy server, if necessary
Password Password for authentication on the proxy server, if necessary
No Proxy (op‐
tional)

• Enable and enter IP addresses which shall be accessed directly (without use of 
proxy)

• Separate multiple no proxy addresses by a comma
• Input of no proxy address is optional but mandatory if you select this check box

Custom Ports • Ports that are needed for using apps on the Edge Device
• Add further ports by clicking the plus button
• Input of ports is optional
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5.4 Layer 2 network access
Some Edge Apps need to communicate with automation devices via automation protocols, such 
as Profinet, DCP and LLDP. That means, these Edge Apps require to be directly connected to the 
physical network at the data link layer (Layer 2 network access). This Layer 2 network access is 
used only for communication with automation devices on the physical network, it is not 
designed to provide communication between app containers. For communication between app 
containers, standard app container communication means must be used. 
When you onboard an Edge Device to the IEM, you define the IP address range of the Layer 2 n
etwork access which is then reserved for communication between Edge Apps and automation 
devices. To install and use Edge Apps on Edge Devices that need to communicate with automa
tion devices, you must enable the Layer 2 network access on the respective Edge Devices durin
g the onboarding procedure. Edge Apps that require a Layer 2 network access can only be inst
alled on Edge Devices with an appropriate configured Layer 2 network access. The Layer 2 net
work access activation and configuration is saved to the Edge Device configuration file.
If you edit a configured Layer 2 network access on the Edge Device while apps running on this 
Edge Device are using the Layer 2 network access, the apps will first stop running. After you ha
ve finished editing the Layer 2 network access, the apps will restart and run again with the ne
w settings. If you remove a configured Layer 2 network access on this Edge Device while apps 
running on this Edge Device are using the Layer 2 network access, the apps will not work anym
ore.
You find information on how to enable the Layer 2 network access for an Edge Device and how to 
configure the IP address range in the following subsections.
You find information on how to create Edge Apps that require a Layer 2 network access in the 
"Industrial Edge App Publisher ‑ Operation (https://support.industry.siemens.com/cs/us/en/
view/109780392)" manual in the "Creating a Layer 2 network access" subsection.

5.4.1 Configuring a Layer 2 network access
Set up a Layer 2 network access on the Edge Device under the "Layer 2 (L2) for Apps" section, as 
shown below for example:

Depending on the starting IP address and the IP range of the Layer 2 network access, defined by 
the subnet that you provide, a certain amount of IP addresses are available for the Layer 2 
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network access. In this example, the IP address range shows 16 reserved IP addresses. Since 1 
IP address is reserved for the gateway and 1 is reserved for the network itself, 14 IP addresses are 
usable. Setting up a Layer 2 network access configuration with just 2 reserved IP addresses is not 
valid since 2 IP addresses are reserved by default, 1 for the gateway and 1 for the network itself. 

To use the Layer 2 network access, the selected IP address range must be minimum 3. 

Note
The amount of usable IP addresses is always displayed in the dialog.

When you click "Advanced Settings", you can specify which IP addresses can be used for the Layer 
2 network access in the defined IP range. After clicking "Advanced Settings", a list with several 
IP addresses, depending on the starting IP address and the IP range, are displayed, as shown 
below for example: 
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By selecting an IP address, the IP address can be used for the Layer 2 network access for apps. By 
not selecting an IP address, the IP address is blocked and will not be used. 
Again, since 1 IP address is reserved for the gateway and 1 is reserved for the network itself, 
minimum 1 IP address other than these 2 must be selected. Otherwise, an error will be displayed.
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By default, the gateway is within the entered IP range. Under "Gateway", you can define an IP 
address for the gateway to obtain 1 more available IP address in the given IP range, but the IP 
address of the gateway must be within the entered subnet.
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If you select the maximum available IP address range back in the "Layer 2 (L2) for Apps" section, 
1 IP address will be also reserved for broadcast, as shown below for example.
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To save the Layer 2 network access changes, click "Apply".

5.5 Settings

5.5.1 Editing network and Layer 2 network access settings
If you want to, you can again edit the configured network settings or set up a Layer 2 network 
access on this Edge Device before you onboard the Edge Device to the IEM.

Connecting an Edge Device
5.5 Settings

Industrial Edge Management - Getting Started 08/22
Getting Started, 08/2022, A5E50177870-AK 161



Procedure
1. In the "Activate Edge Device" screen, click "Settings".

The "Settings" screen is displayed. 

Note
Connected network interface
When you select a network interface, for example X1 or X2, during the creation of the Edge 
Device configuration file that should be used to connect the Edge Device to the IEM, the 
respective network interface will be also displayed in this screen.

2. To edit the network settings, click the  icon.
The "Edit Network Interface" screen is displayed. 
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3. Configure the IP address, either automatically through DHCP server or through static 
information, and the DNS server as required.
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4. Edit the configured Layer 2 network access or set up a Layer 2 network access on this Edge 
Device under the "Layer 2 (L2) for Apps" section, as shown below for example. 

Note
Removing Layer 2 network access
If you remove a configured Layer 2 network access on this Edge Device and if apps, that are 
running on this Edge Device, are using the Layer 2 network access, the apps will not work 
anymore.
You find more information on the Layer 2 network access in the "Layer 2 network access 
(Page 156)" and the "New Edge Device - Parameters (Page 153)" subsections. 
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5. When you click "Advanced Settings", you can specify which IP addresses can be used for the 
Layer 2 network access for apps in the defined IP range. 
After clicking "Advanced Settings", a list with several IP addresses, depending on the starting 
IP address and the IP range of the Layer 2 network access, are displayed, as shown below for 
example: 

By selecting an IP address, the IP address can be used for the Layer 2 network access for apps. 
By not selecting an IP address, the IP address is blocked and will not be used. By default, the 
gateway is within the entered IP range. Under "Gateway", you can define an IP address for the 
gateway to obtain 1 more available IP address in the given IP range, but the IP address of the 
gateway must be within the entered subnet.
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6. To save the Layer 2 network access changes, click "Apply".
7. To save all changes, click "Update".

5.5.2 Setting up a proxy server
With the use of a proxy server, the admin of the IEM (and of Edge Devices) can add, edit and 
remove proxy rules to redirect specific data traffic. The admin can also disable redirection of 
specific data traffic through the proxy.
App developers do not need to implement their own proxy settings. The proxy settings described 
in this procedure apply for all IEM components.
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Procedure
1. Click the "Proxy" tab.

2. To use a proxy server, click the "Use a proxy server" check box.
The input fields for the proxy server settings are enabled.

3. Enter the IP address and the corresponding port of the proxy server in the according input 
fields. 

4. If needed, enter username and the corresponding password in the according input fields in 
case of an additional authentication for the proxy server. 
When authentication is required, the password must match the following criteria:
– The password must start with an alphabetic character
– The password must not contain complex characters, such as \ . * " 
– The password must not be longer than 21 characters 
The settings apply for HTTP and HTTPS proxy servers.
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5. Click "Next".
The "No Proxy" tab is displayed. 

In the "No Proxy" tab, add all the IP addresses which shall be accessed directly (without use 
of proxy). 
By default, several no proxy addresses are listed which are required by the IEM.

6. If you want to add a further IP address which shall be accessed directly, enter the IP address 
or domain of the no proxy address in the "IP" input field and click the  icon.  
The address is added to the no proxy list.
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7. Click "Next". 
The "Custom Port" tab is displayed. 

In the "Custom Port" tab, you configure ports for apps which use the configured ports for 
outgoing communication through the proxy on HTTPS or HTTP protocols. For your apps, use 
ports between the port range 32768-60999.
By default, several ports are listed which are required by the IEM.
Note
Default no proxy addresses and ports
The default no proxy addresses and ports are essential for running the IEM and cannot be 
deleted.

8. If you want to add a further port, select the required protocol from the "Protocol" drop-down 
list and enter the required port.

9. To add the port, click the  icon.
The port is added to the port list.

10.To add the proxy settings, click "Configure".
11.Confirm the proxy settings by clicking "Ok".

The proxy settings are saved. 
Note
Setting up a proxy server after onboarding the Edge Device
You can also configure and update the proxy settings after you have onboarded the Edge 
Device to the IEM. In the Edge Device UI, navigate to the "Settings > Connectivity > Proxy 
Network" section and set the proxy settings. 
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5.5.3 Configuring the Docker network
In the "Docker Network" tab, you can edit the IP range of the docker0 interface of the Edge 
Device, if necessary. 
The IP address of the docker0 interface is the start of the docker0 interface. By default, the 
docker0 interface starts with 172.17.0.0. By default, the Edge Device contains 2 Docker 
networks, 1 for the proxy-redirect and 1 for the docker0 interface (that you create in the "IP 
Address" input field). When you install an app which creates a new Docker network on the Edge 
Device, the Docker network of the installed app must not overlap the Docker networks of the 
Edge Device and need free Docker network IP ranges on the Edge Device. Otherwise, if you want 
to install an app that tries to create a new Docker network on the Edge Device but the Edge 
Device has no free Docker network IP ranges, the app installation fails. 
You can just edit the IP range in a given range with a specific netmask to prevent errors in the 
system. 

Procedure
1. In the "Settings" screen, click the "Docker Network" tab.
2. In the "IP address" input field, enter the IP address that you want to use for the docker0 

network.

3. To save the settings, click "Configure".
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5.5.4 Downloading logs

Procedure
1. Click the "System" tab.

2. Click the "Download Logs" tile. 
The log file is being downloaded to the standard download folder of your Internet browser.

5.5.5 Editing log settings
By default, Edge Apps are enabled to log into the internal memory of the Edge Device. Under 
"Log Settings", you select the log levels that are being logged into the internal memory. 
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Procedure
1. Click the "System" tab.

2. Click the "Log Settings" tile. 
The "Log Settings" screen is displayed.

 By default, Edge Apps are enabled to log into the internal memory of the Edge Device. The 
"Info" log level is selected by default which means that all log levels up to this level are 
generated.

3. If you want to disable logging into the internal memory of the Edge Device, deselect the 
"Enable Logs" check box.

4. If you want to keep logging enabled, select the log level you want to log into the internal 
memory from the drop-down list.
All log levels up to this selected log level are generated and logged into the internal memory.

5. To save your changes, click "Update".

5.5.6 Adding an NTP server
A flawless operation of the Industrial Edge Management and Edge Devices require time 
synchronization of the Industrial Edge Management and Edge Devices. To properly synchronize 
the time on the Industrial Edge Management and Edge Devices, an NTP server is recommended.
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If you already have added an NTP server during the configuration of the Industrial Edge 
Management OS and use the same NTP server for your Edge Devices, you can skip this procedure.

Procedure
1. Click the "System" tab.

2. Click the "NTP Server" tile.
The "NTP Server" screen is displayed.

3. If you have not added minimum 1 NTP server or you want to add more NTP servers, enter the 
NTP server in the "Server Name" input field.

4. To add the NTP server, click the plus icon. 
The NTP server is added to the server list. You can add several NTP servers. In case that 1 of 
them is unavailable, the next NTP server from the list will get active.

5. Click "Submit". 
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5.6 Secure connection

Connected Edge Device with self-signed certificates or certificates from the IEM
When you create a new Edge Device in the Management UI with self-signed certificates or 
certificates from the IEM itself and enter the IP address of the Edge Device into the Internet 
browser, you notice that the connection is not secure. After you browse the created 
configuration file of the Edge Device and connect the Edge Device to the IEM, the connection to 
the Edge Device is still not secure. Import the self-signed certificates or the certificates from the 
IEM itself to the settings of the Internet browser according to the "Importing certificates to the 
Internet browser" subsection and to the Edge Device according to the "Importing certificates" 
subsection, both described in the "Industrial Edge Management - Operation (https://
support.industry.siemens.com/cs/us/en/view/109780393)" manual. After you have imported 
the certificates, refresh the Internet browser of the Edge Device UI. The connection is secure now.

Connected Edge Device with wildcard or SAN certificates
When you create a new Edge Device in the Management UI with wildcard or SAN certificates and 
enter the IP address of the Edge Device into the Internet browser, you notice that the connection 
is not secure. After you browse the created configuration file of the Edge Device and connect the 
Edge Device to the IEM, the connection to the Edge Device is secure. This secure connection 
requires that the CA-chain is imported to the settings of the Internet browser. 
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Installing an app 6
To get apps in general into the IEM, you have the following possibilities:
• Copying apps directly from the IE Hub to the IEM instance
• Uploading apps through the IE App Publisher to the IEM
• Importing apps through the "Import Application" button in the "Catalog" screen in the 

Management UI
The following subsections describe the procedure on how to copy an app from the IE Hub to the 
IEM instance and om how to install them. 

6.1 Copying apps to the IEM
The following procedure describes the transfer of the "IE Databus" System App from the IE Hub 
to the IEM. Proceed in the same manner for every other app.

Procedure
1. Log into the IE Hub.
2. In the navigation menu, click "Library".
3. Click the copy icon of the "IE Databus" app.

The "Copy Application to IEM catalog" screen is displayed.
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4. From the drop-down list, select the IEM instance to which you want to copy the app to.
5. Click "Copy".

The app is being transferred to the catalog in the Management UI of the selected IEM 
instance. You can check the status of the transfer by clicking the jobs icon in the respective 
Management UI.

When the transfer is completed, the app is available in the catalog.

To install the System App, you must add Edge Devices to the IEM.

6.2 Installing apps on Edge Devices
The following procedure describes the installation of the "IE Databus" System App. Proceed in 
the same manner for every other app.

Requirement
• Minimum 1 Edge Device is connected and running in the IEM.
• The app is available in the catalog of the Management UI. 

Installing an app
6.2 Installing apps on Edge Devices
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Procedure
1. In the navigation menu in the Management UI, click "Catalog".
2. Click the app tile, in this example the "IE Databus" System App.

The app details are displayed.

Note
Verified Edge Apps
Verified and trusted Edge Apps by Siemens are marked with the  icon.

3. Click "Install".
The "Install App" screen is displayed.

4. Without selecting a configuration, click "Next". 

Installing an app
6.2 Installing apps on Edge Devices
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5. Select the Edge Devices on which you want to install the app.

You can select several Edge Devices to install the app to.
6. Click either "Install Later", "Install Now" or "Install Delayed".

"Install Now" installs the app immediately. When you click "Install Later", select an installation 
time. When you select "Install Delayed", you can delay the installation within the next 60 
minutes. You can select a delay time according to your network configuration and app size. 
In this case, the installation job will be created indeed (in "Pending" status) but will not be 
executed until the selected delayed time has passed.
Note
Installation time
When you select "Install Later", a calendar and the local system time is displayed for selecting 
the installation date and time.
You can check the installation status in the "Job Status" menu item. After the app is installed 
successfully, the app is listed under "My Installed Apps" in the Management UI of the IEM.

Installing an app
6.2 Installing apps on Edge Devices

Industrial Edge Management - Getting Started 08/22
178 Getting Started, 08/2022, A5E50177870-AK



6.3 Launching apps configured by a configurator
To use the "IE Databus" System App and some other special apps, the according configurator 
must be installed in the Maintenance UI of the IEM, as described in the "Installing configurators 
(Page 134)" subsection. These configurators can only launch (and configure) the respective app 
when the app is installed on your Edge Devices. Apps that are being configured by a 
configurator and that are installed on Edge Devices are also considered as runtime apps.

Requirement
• The configurator is installed in the Maintenance UI of the IEM.
• The respective runtime app is installed on an Edge Device.

Installing an app
6.3 Launching apps configured by a configurator
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Procedure
1. In the Management UI, navigate to "Data Connections".

Apps configured by a configurator are displayed in the "All System Apps" tab.

2. Click the tile of the respective app, in this example the "IE Databus" System App. 
The "Launch App" screen is displayed.

Installing an app
6.3 Launching apps configured by a configurator
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3. Select the Edge Device on which the app is installed and which you want to launch.

Only Edge Devices on which the app is installed are available. You can only select 1 
Edge Device. 

4. Click "Launch".
The app is launched and will be opened in a new tab inside the "Data Connections" screen. 
In that way, you can launch several apps on different Edge Devices and swicth between the 
apps through the tabs.

The tab displays the app name and the respective Edge Device.

Installing an app
6.3 Launching apps configured by a configurator
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Installing an app
6.3 Launching apps configured by a configurator
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Example of use - Monitoring bottle filling process 7
7.1 Description

This example uses the self-created "Archiving & Visualization" app which is based on a bottle 
filling process application from which data values are collected, stored in an Influx-Database 
(InfluxDB) and visualized via a Grafana dashboard. 

General task
The "Archiving & Visualization" app collects data from an S7-1500 PLC by using the SIMATIC S7 
Connector Configurator. The collected data is automatically published to the IE Databus which 
is an internal MQTT broker of Industrial Edge. The "Archiving & Visualization" app uses a MQTT 
client (data collector) to subscribe to the IE Databus and write these values into an Influx-
Database. The time series of the collected data can then be plotted within the Grafana 
dashboard. 

Structural overview
The following figure shows a simplified structural overview of this example:
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7.2 System setup and requirements

System setup
This example is applied with the following system setup:
• Industrial Edge App Publisher UI: V1.3.7
• Industrial Edge Management: V1.3.8
• SIMATIC S7 Connector Configurator: V1.3.40
• SIMATIC S7 System App: V1.3.21
• IE Databus Configurator: V1.3.5
• IE Databus System App: V1.3.2
• Industrial Edge Device: V1.3.0

Additional tools and requirements
• OS: Linux
• Docker version 18.09
• Docker-compose version 2.4
• Development environment Visual Studio Code
• TIA Portal V16
• PLC: CPU 1511 FW 2.8.3

SIMATIC S7 Connector Configurator
In this example, the SIMATIC S7 Connector Configurator is used in the "Bulk Publish" mode to 
collect tags from the TIA Portal project "Tank Application". The used PLC name is "PLC_1" and the 
following tags are being collected:
• GDB_signals_tankSignals_actLevel (Read/100ms)
• GDB_signals_tankSignals_actTemperature (Read/100ms)
• GDB_process_numberProdued (Read/100ms)
• GDB_process_numberFaulty (Read/100ms)
• GDB_hmiSignals_HMI_Nextbottle (Read&Write/100ms)

IE Databus Configurator
In this example, the IE Databus Configurator is configured with following parameters:
• Topic: ie/# 
• Username: edge 
• Password: edge

Example of use - Monitoring bottle filling process
7.2 System setup and requirements
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7.3 Building the app
To build respectively create the app, you must download the needed resources from a public 
Github repository and afterwards build the app in your IDE, in this case Visual Studio Code.

Procedure
1. Open the Github repository under the following link (https://github.com/industrial-edge/

archiving-and-visualization).
2. Clone the repository by clicking "Code" and the download icon under the "HTTPS" section.

3. Open Visual Studio Code.
4. Display the command palette by entering <CTRL>+<SHIFT>+<P>.
5. In the command palette, search for "Git: Clone" and select it.

Example of use - Monitoring bottle filling process
7.3 Building the app
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6. Paste the cloned GitHub repository and perform the "Clone from URL" command.

7. Select or create the folder you want to clone the repository to.
The repository is cloned to the selected folder.

8. In the command shell, navigate to the ".../archiving-and-visualization/" folder of the cloned 
repository.
The docker-compose.yml file should be located in this folder.

9. Build the app by entering the docker-compose build command into the command shell.
The InfluxDB and Grafana container are being created. 

7.4 Creating the project and app in the Industrial Edge Management

Procedure
1. Open and log into the Management UI.
2. Navigate to "App Projects". 

Example of use - Monitoring bottle filling process
7.4 Creating the project and app in the Industrial Edge Management
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3. Create an own project for the app by clicking "Create Project".
The "Create Project" screen is displayed.

4. Enter all required information:
– Project Name
– Description
– Company Information

5. Click "Next".
In the following screen you create the app on the IEM side.

Example of use - Monitoring bottle filling process
7.4 Creating the project and app in the Industrial Edge Management
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6. Enter all required information:
– Application Name
– Repository Name
– Website
– Description
– Category
– Icon 

Example of use - Monitoring bottle filling process
7.4 Creating the project and app in the Industrial Edge Management
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Note
"Use Edge Device Auth Service", "Labels" and "External configurator"
Do not select these options since it is not required for this app.

7. Click "Create".
The project and app has been created in the IEM. 
Now you must create the app version including its configuration in the IE App Publisher and 
upload it to the created project respectively app.

7.5 Creating the app version in the IE App Publisher

Requirement
• Connected to the IEM.
• Connected to a Docker engine.
You find information on how to connect to the IEM and to a Docker engine in the "Connecting 
the IE App Publisher" section in the "Industrial Edge App Publisher - Operation (https://
support.industry.siemens.com/cs/us/en/view/109780392)" manual.

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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Procedure
1. Open and log into the IE App Publisher.
2. In the "My Projects" section, select the created project and click the newly created app tile.

The version table is displayed.
3. Click "Configurations".
4. Add a new configuration by clicking "Add Configuration".

The app configuration screen is displayed.
5. Enter all required information:

– Display Name
– Description
– Host Path
– Template Name
– Template Description
– Template File

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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6. For the template file, click "Browse" and select the "env-config.json" file which is contained in 
the ".../cfg-data/" folder in the cloned repository.

7. Click "Add".
The app configuration has been created.

8. In the version table, click "Add New Version".

The "Create Version" screen is displayed.

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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9. From the drop-down list, select the 2.4 docker-compose version and click "Ok".
10.Click "Import YAML" and select the "docker-compose.yml" file from the cloned repository.

11.Click "Ok".
The contained services and network parameters are displayed.

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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12.If needed, configure a reverse proxy by clicking the  icon in the "grafana" service section 
and clicking the "Network" tile.
A reverse proxy is a proxy server that is preconnected to a webserver to protect the webserver 
from direct access from the public network/Internet. Public clients will not get direct access 
to the destination server. Requests are taken from clients and can be checked by security 
rules. After the checks, the request can be sent to a server instance. In Industrial Edge, the 
reverse proxy is handling the incoming requests, such as opening the IE Flow Creator or a 
Grafana dashboard for data visualization. 
In the "Network" screen, add the reverse proxy information.

Note
Port exposure
Port exposure must be removed in this case. For that, click the  icon at the bottom of the 
"Network" screen.
After you have configured, the reverse proxy, save the changes.

13.Click "Review".

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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14.Click "Validate & Create".
The "Add Version" screen is displayed.

15.Click "Create".
This process may take some time. After the app version has been created, the version is listed 
in the version table and ready to upload.

16.Click "Start Upload".

The app version is getting uploaded to the IEM. Once the app version is successfully uploaded 
to the IEM, you must install the app version onto your Edge Device.

Example of use - Monitoring bottle filling process
7.5 Creating the app version in the IE App Publisher
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7.6 Installing the app

Procedure
1. In the Management UI, navigate to "App Projects".
2. Open the project in which the app has been created. 
3. Click the tile of the created app.

All available versions of the app are displayed. 
4. Install the app version by clicking the  icon under "Actions". 

The "Install App" screen is displayed. 

Example of use - Monitoring bottle filling process
7.6 Installing the app
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5. In the "Configurations" tab, click the  icon to review your configuration file. 
Based on this configuration, you can configure the app to use a different database name, 
different credentials for the IE Databus or a different datasource name. 
In this example, "PLC_1/default" is entered under "DATA_SOURCE_NAME" because the used 
PLC name in the SIMATIC S7 Connector is "PLC_1" and the "Bulk Publish" publish option is 
enabled, so the "default" keyword is needed.

6. Select the configuration file.

7. Click "Next".
8. Select the Edge Device on which you want to install the app.
9. Click "Install Now".
10.To install the app, click "Allow".

The app is being installed. You can check the installation status in the "Job Status" menu item. 
When the app has been installed successfully, you can start the app from the Edge Device UI 
of the respective Edge Device.

Example of use - Monitoring bottle filling process
7.6 Installing the app
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7.7 Starting the app

Requirement
• The SIMATIC S7 Connector project is started. 
• Your PLC is in "Start" mode.
• "GDB".hmiSignals.HMI_Start is set to TRUE on your PLC.

Example of use - Monitoring bottle filling process
7.7 Starting the app
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Procedure
1. Open and log into the Edge Device UI on which you installed the app.
2. In the "Apps" screen, click the tile of the app to start it.

The app will be opened in a new tab and the Grafana login screen is displayed.

Example of use - Monitoring bottle filling process
7.7 Starting the app
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3. Log in with the following credentials:
– Username: admin
– Password: admin

4. Change the password.
The Grafana home screen is displayed.

5. On the left side, navigate to "Configuration > Data Sources".

6. Click "Add data source".

Example of use - Monitoring bottle filling process
7.7 Starting the app
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7. Add the new "InfluxDB" data source by entering "InfluxDB" in the search bar and selecting it.

The data source is added.
8. In the "URL" input field under the "HTTP" section, enter the "http://influxdb:8086" address.

Example of use - Monitoring bottle filling process
7.7 Starting the app
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9. In the "Database" input field under the "InfluxDB Details" section, enter the "databus_values" 
database name.

10.Click "Save & Test".
You should receive a notification "Data source is working". If not, you might have selected a 
different name in the configuration file. In that case, check again the configuration file.

Example of use - Monitoring bottle filling process
7.7 Starting the app
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11.In the "Dashboard" section, add a new panel.
You are able to select and configure your tags.

12.Select the values you want to plot.
13.Remove the "Group By" options and the "SELECT mean(value)" option.

The tag values, and by that the bottle filling process, are displayed and monitored via the 
dashboard.

Example of use - Monitoring bottle filling process
7.7 Starting the app
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List of abbreviations/acronyms 8
Abbrevia‐
tion

Description

IE Industrial Edge
IED Industrial Edge Device
IEH Industrial Edge Hub
IEM Industrial Edge Management
IEMA Industrial Edge Management App
IERT Industrial Edge Runtime
IEAP Industrial Edge App Publisher
IED-OS Industrial Edge Device Operating System
IEM-OS Industrial Edge Management Operating System
VM Virtual Machine
UI User Interface
CLI Command Line Interface
IEFC Industrial Edge Flow Creator
SAS Shared Access Signature
SSH Secure Shell
IoT Internet of Things
DHCP Dynamic Host Configuration Protocol
API Application Programming Interface
TPM Trusted Platform Module
LAN Local Area Network
FQDN Fully Qualified Domain Name
NTP Network Time Protocol
L2 Layer 2
LLDP Link Layer Discovery Protocol
CIDR Classless Inter-Domain Routing 
IEACS Industrial Edge Application Configuration Service
IEDK Industrial Edge Device Kit
IECTL Industrial Edge Control
IESS Industrial Edge State Service
DEX Digital Exchange
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Glossary

.app file
File extension for IE Edge Apps.

3rd Party Industrial Edge App
3rd Party IE Apps are not provided by Siemens, but by 3rd party providers.

Admin UI
Included in the Industrial Edge Management App. UI enabled for admins and users with admin 
permissions to manage IED-OS versions and registered users for example.

Application Programming Interface (API) 
In computing, an Application Programming Interface (API) is an interface that defines 
interactions between multiple software applications or mixed hardware-software 
intermediaries. It defines the kinds of calls or requests that can be made, how to make them, the 
data formats that should be used, the conventions to follow and so.

Centrally-managed Edge
Edge Device and Edge App management is done centrally in the Industrial Edge Management.

Classless Inter-Domain Routing (CIDR) 
Classless Inter-Domain Routing (CIDR) is the successor to class-oriented domains for Internet 
routing and enables better allocations of Internet addresses. It combines a number of class C 
Internet Protocol (IP) addresses to reduce the burden on routing tables in the Internet.

Container
Containers are isolated environments on a shared operating system. Unlike VMs, containers do 
not bundle a full operating system, but only required libraries and settings for running the 
intended software. Containers are isolated on the kernel layer. This makes for efficient, 
lightweight, self-contained systems and guarantees that software will always run the same 
regardless of where it is deployed.

Data source
A data source is a physical element of a device, e.g. OPC-UA Server or S7, which collects data in 
the automation level.
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Device-OS
Operating system used by Device Builders to integrate into the IED-OS.

Disaster Recovery (DR) 
Disaster Recovery (DR) is an area of security planning that aims to protect an organization from 
the effects of significant negative events. Having a disaster recovery strategy in place enables an 
organization to maintain or quickly resume mission-critical functions following a disruption.

Docker
Docker is a container platform that eases configuring, creating and sharing specific development 
environments and packaging software to be deployed everywhere. Docker provides a runtime 
and image format and a command line interface.

Industrial Edge
Industrial Edge represents an open, ready-to-use Edge computing platform consisting of Edge 
Devices, Edge Apps, Edge connectivity and an app and device management infrastructure. It 
enables collecting and analyzing data from industrial resources, enables a faster and more 
reliable rollout of apps on the shop floor, and provides central management for devices and apps 
with maximum scalability – with no need to intervene in the existing automation system (for 
example, to adapt controller software). Depending on your requirements, you can determine 
data that stays locally and data that can be used with a cloud solution on an optional basis.

Industrial Edge App Configuration Service (IEACS)
The Industrial Edge App Configuration Service enables to display templated app configuration 
files. App developers, that used templated app configurations in their applications, benefit from 
displayed forms in the Management UI and gain advantage of input validation, error messages 
and highly improved usability for the customer.

Industrial Edge App Publisher (IEAP)
Software application that enables packaging and publishing of Industrial Edge Apps. The IEAP 
is available as Linux and Windows application.

Industrial Edge App Publisher CLI 
Command Line Interface of the Industrial Edge App Publisher to use the IEAP in a build pipeline 
for example.

Industrial Edge Cloud Connector
App for data distribution to data services of cloud providers.

Glossary

Industrial Edge Management - Getting Started 08/22
206 Getting Started, 08/2022, A5E50177870-AK



Industrial Edge Cloud Connector Configurator
Configurator for the IE Cloud Connector. In contrast to the IE Cloud Connector, the IE Cloud 
Connector Configurator is executed in the IEM and not on the Edge Device.

Industrial Edge Connectors 
Connecting to external systems to exchange data (without preprocessing). The name is derived 
from the protocol that is being used to connect to the system, for example the SIMATIC S7 
Connector is derived from SIMATIC S7 protocol.

Industrial Edge Control (IECTL)
The Industrial Edge Control (IECTL) is a Command Line Interface to interact with Industrial Edge 
and its components.

Industrial Edge Databus
System App for data distribution in Industrial Edge.

Industrial Edge Databus Configurator
Configurator for the IE Databus. In contrast to the IE Databus, the IE Databus Configurator is 
executed in the IEM and not on the Edge Device.

Industrial Edge Device Kit (IEDK) 
Abstraction layer that separates hardware specifics from the operating system with the software 
functionality of the IERT.

Industrial Edge Device License
License (subscription) which customers purchase from Siemens. The Edge Device license 
includes the annual fee for each Industrial Edge Device that is centrally managed through an IEM.

Industrial Edge Device OS (IED-OS)
Software (Operating System) that is running on a SIMATIC IPC Edge Device. The IED-OS enables 
SIMATIC IPCs to be managed as Edge Device.

Industrial Edge Ecosystem
The Industrial Edge Ecosystem builds on top of the IE Platform and serves for value creation by 
partners, such as App Providers, Device Builders, Solution Partners and others.

Glossary
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Industrial Edge Hub Access 
Offer that is available in the Siemens Industry Mall. The offer includes access to the Industrial 
Edge Hub.

Industrial Edge Management License
License (subscription) which customers need to buy in the Industry Mall or marketplace. The 
management license for IE Devices includes the annual fee to manage an Industrial Edge Device.

Industrial Edge Management On-Premises
IEM On-Premises describes the installation and use of IEM on computers at the premises of the 
organization using the software, not at a remote facility. IEM is operated by the customer.

Industrial Edge Management OS (IEM-OS)
The IEM-OS is the core orchestration engine of the Industrial Edge Management. Hosts IEM 
Services and provides service capabilities.

Industrial Edge Management Services 
Applications that are provided with the IE Hub Access and that are free of charge. An IEM Service 
extends the IEM basic functionality. The IEM App, Device Catalog, IE State Service or the IE App 
Configuration Service belong to IEM Services.

Industrial Edge Marketplace
Marketplace beside the Industry Mall to purchase IE Apps.

Industrial Edge Platform 
Consists of the Industrial Edge Hub, the Industrial Edge Management and Industrial Edge 
Devices.

Industrial Edge Runtime (IERT)
Software component that is running within the IEM-OS and IED-OS.

Industrial Edge Service Medium 
Software artifact (*.iso) provided to flash onto USB flash drives. It is used to get log files of 
bricked Edge Devices and to reset Edge Devices.

Industrial Edge State Service (IESS)
The Industrial Edge State Service is an IEM service that provides the possibility to implement 
Disaster Recovery (DR) strategies based on your DR plan respectively requirements. With the IE 
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State Service, you can store the IED state of an Edge Device on the IEM and restore a required 
stored IED state on the Edge Device in case of any occuring errors respectively failures in the Edge 
Device. 

Industrial Edge System App
The IE Databus is considered as the only System App. The System App is an application that is 
provided free of charge with the IE Hub Access. It provides the data distribution in Industrial 
Edge. In comparison to Edge Apps, the System App is shipped with the IEM by default and is 
given special rights because it provides essential functionality for the IEM.

Industrial Edge App
Overall name for software applications which are distributed on the Industrial Edge Device. Apps 
always have a direct benefit for the user (backbone of value delivery) but are limited in their 
functionality. It can consist of one or more Docker containers. Siemens is not possible in the 
product name.

Industrial Edge Device (IED)
A hardware device which includes the Edge Device OS, provided by a Device Builder, with the 
purpose of providing Industrial Edge functionality. Industrial Edge Apps can be deployed on 
Edge Devices. Contains the Industrial Edge Runtime (IERT).

Industrial Edge Hub (IEH)
The Industrial Edge Hub (IEH) is the entry point for Siemens customers into Industrial Edge and 
the central starting point for downloading and configuring the Industrial Edge Management 
(IEM). In the IEH, you download all necessary software for running the IEM and manage licenses 
of purchased Edge Apps and Edge Devices. Also, the IEH provides a global catalog from which 
you download Edge Apps and distribute to the Industrial Edge Management.

Industrial Edge Management (IEM)
Central user interface of Industrial Edge. The IEM provides Edge App and Edge Device 
management, as well as system-internal configurations, such as the settings for connections to 
controllers. The IEM runs locally in a VM based cluster.

Layer 2 
The data link layer, or layer 2, is the second layer of the seven-layer OSI model of computer 
networking. This layer is the protocol layer that transfers data between nodes on a network 
segment across the physical layer.

Maintenance UI
UI to install and update IEM Services, configurators and the Industrial Edge Management App, 
as well as UI to configure IEM settings. 
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Management UI
Included in the Industrial Edge Management App and central user interface of Industrial Edge. 
The Management UI provides, amongst others, Edge App and Edge Device management. 

Network Time Protocol (NTP) 
The Network Time Protocol (NTP) is a networking protocol for clock synchronization between 
computer systems over packet-switched, variable-latency data networks.

Organization 
Organization is an instance of the Industrial Edge Hub in which you manage resources such as 
licenses, IEM instances, users and other entities such as Edge Device types and apps. You can 
own or be a member of more than one organization to distinguish between different user 
groups.

Secrets
Secrets are sensitive data that generally must be protected.

Shared Access Signature (SAS) 
A shared access signature (SAS) provides secure delegated access to resources in your storage 
account without compromising the security of your data. With a SAS, you have granular control 
over how a client can access your data. You can control what resources the client may access, 
what permissions they have on those resources and how long the SAS is valid, among other 
parameters.

Side loading
Describes the process of bringing IE Apps into the IE Platform without need of the IE Hub. Side 
loaded apps can harm the system as Siemens has neither verified nor signed these applications. 
The operator owns the responsibility for any impact to the IE Platform due to side loaded apps.

Siemens Digital Exchange (DEX)
The Siemens Digital Exchange (DEX) is the (Industrial Edge) marketplace for purchasing digital 
products as well as services. This eCommerce marketplace seamlessly connects customers to 
catalogs of Siemens and third-party software products and services. The DEX is reachable under 
this link.

SIMATIC S7 Connector
App that provides connectivity to the plant network.
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SIMATIC S7 Connector Configurator
Configurator for the SIMATIC S7 Connector. In contrast to the SIMATIC S7 Connector, the SIMATIC 
S7 Connector Configurator is executed in the IEM and not on the Edge Device.

Tags 
Tags refer to elements (variables), which allow values to be obtained from data sources (OPC-UA 
or S7 etc.). They are combined into a relevant aspect. For example, "temperature" and "torque" 
are data points of the aspect "Energy_consumption". Tags are configured in SIMATIC S7 
Connector Configurator.

Topic
A topic is a permanently defined access area. Measured data can be sent to a specific topic or 
access area. Only users who have access to the area are allowed to use the data. The access area 
is defined by the name of the topic.

Trusted Platform Module (TPM)
Trusted Platform Module (TPM) is an international standard for a secure crypto processor, a 
dedicated microcontroller designed to secure hardware through integrated cryptographic keys.

Virtual Machine (VM)
A Virtual Machine (VM) imitates dedicated hardware and runs an operating system. Software 
running inside the VM and end users have the same experience as on a dedicated system. IaaS 
providers use a so called hypervisor which provides the VM with the configured hardware which 
is provided by the host. In the IaaS environment the type of hardware can be almost anything 
that is available in a data center.
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